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Simscape Power Systems Product Description
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Model and simulate electrical power systems

Simscape Power Systems provides component libraries and analysis tools for modeling
and simulating electrical power systems. It includes models of electrical power
components, including three-phase machines, electric drives, and components for
applications such as flexible AC transmission systems (FACTS) and renewable energy
systems. Harmonic analysis, calculation of total harmonic distortion (THD), load flow, and
other key electrical power system analyses are automated, helping you investigate the
performance of your design.

Simscape Power Systems helps you develop control systems and test system-level
performance. You can parameterize your models using MATLAB® variables and
expressions, and design control systems for your electrical power system in Simulink®.
You can integrate mechanical, hydraulic, thermal, and other physical systems into your
model using components from the Simscape family of products. To deploy models to other
simulation environments, including hardware-in-the-loop (HIL) systems, Simscape Power
Systems supports C-code generation.

Simscape Power Systems was developed in collaboration with Hydro-Québec of Montreal.

Key Features

* Application-specific models, including common AC and DC electric drives, flexible AC
transmission systems (FACTS), and renewable energy systems

* Discretization and phasor simulation modes for faster model execution
+ Ideal switching algorithm for accelerated simulation of power electronic devices

* Analysis methods for obtaining state-space representations of circuits and computing
machine load flow

* Basic models for developing key electrical technologies
* MATLAB based Simscape language for creating custom component models
* Support for C-code generation (with Simulink Coder™)
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Simscape Power Systems Block Libraries

Overview of Simscape Power Systems Libraries

Simscape Power Systems contains two top-level block libraries, representing two different
technologies.

Simscape Components Library

The Simscape Power Systems Simscape Components library contains Simscape blocks
specifically developed for working with multiphase electrical domains. In addition to the
Simscape Foundation domains, the product contains a three-phase electrical domain, and
you can use this domain to develop your own custom three-phase blocks with Simscape
language. You can also view and customize source for several machine and transformer
example blocks provided with the product.

The main Simscape Components library is called pe_lib. It contains Simscape blocks with
three-phase and single-phase electrical ports, as well as mechanical rotational and
translational ports. These blocks are organized into sublibraries according to their
function. You can connect these blocks directly to other Simscape blocks, from the
Foundation library or from the other add-on products.

Three-phase electrical ports on Simscape Components blocks are collapsed by default, to
support single-line diagrams. You can optionally expand them to separate the phases, for
example, to inject a single-line-to-ground fault into your circuit.

Specialized Technology Library

The Simscape Power Systems Specialized Technology library contains models of typical
power equipment such as transformers, lines, machines, and power electronics. These
models are proven ones coming from textbooks, and their validity is based on the
experience of the Power Systems Testing and Simulation Laboratory of Hydro-Québec, a
large North American utility located in Canada, and also on the experience of Ecole de
Technologie Supérieure and Université Laval. The capabilities of Simscape Power
Systems software for modeling a typical electrical system are illustrated in example files.
For users who want to refresh their knowledge of power system theory, there are also
self-learning case studies.

The main Specialized Technology library is called simscapepowersystems_ST. It
contains sublibraries of blocks that are organized according to their behavior. The

1-3
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Fundamental Blocks sublibrary contains the Powergui block, which contains tools for the
steady-state analysis of electrical circuits.

Using the Simulink Library Browser to Access the Block
Libraries

You can access both Simscape Power Systems libraries through the Simulink Library
Browser. To display the Simulink Library Browser, at the MATLAB command prompt,
enter slLibraryBrowser. In the left pane of the library browser, scroll to the Simscape
node. Expand the Simscape node and then the Power Systems node.

HESimulink Library Browser E'@
(.::j Enter search term - f‘q - i > ~| = G)
Simscape/Power Systems

4 Simscape s
* Foundation Library
Utilities /
+ Driveline
» Electronics Simscape Components

* Fluids

> Multibody
4 Power Systems
+ Simscape Components =

- Spedialized Technology -
Fl il s

Spedialized Technology

You can also use the library browser to access the Simscape Power Systems libraries from
a Simulink model window. In the toolbar of the model window, click the Library Browser

OE
button \EE),

Using the Command Prompt to Access the Block Libraries

To access the libraries that the table describes, enter the relevant command at the
MATLAB command prompt.

Library Description Command

Simscape Power Systems Top-level libraries in simscapepowersystems
Simscape Power Systems




Simscape Power Systems Block Libraries

Library Description Command
Simscape Power Systems Simscape Components pe lib
Simscape Components blocks
Simscape Power Systems Specialized Technology simscapepowersystems ST
Specialized Technology blocks
Simscape Power Systems Powergui block, interface powerlib
Specialized Technology elements, and other
Fundamental Blocks fundamental Specialized
Technology blocks
Simscape Simscape utility blocks, simscape

single-phase electrical
sources, sensors, and other
Foundation library blocks

Simulink Generic Simulink blocks slLibraryBrowser
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Comparison of Simscape Components and Specialized
Technology

Simscape Power Systems software includes two technologies and corresponding libraries
to model and simulate electrical power systems. You can create and simulate systems
using either library. A single Simscape Power Systems model can contain components
from both libraries. You use electrical ports to connect the components within each
technology and, ultimately, use Simulink signals to connect Simscape Components blocks
to Specialized Technology blocks.

1-6

Simscape Components libraries use the full range of Simscape technology, and the
component models are written in the Simscape language. You can directly connect
these models with the Simscape Foundation library components and with components
from other add-on products. You can view and customize the Simscape language
source code examples for machines and transformers. Simscape Components models
are fully compatible with Simscape technology, including local solver and data logging.

Simscape Components also provides three-phase electrical connection ports, which
you can individually expand into separate phases as needed. By default, these three-
phase ports are collapsed, to support single-line diagrams.

Specialized Technology libraries provide components and technology specifically
developed for electrical power systems. The Specialized Technology library has been
refined and tuned for more than a decade. Specialized Technology models use their
own electrical domain. You connect Specialized Technology blocks to other Simscape
elements ultimately through Simulink signals. The Specialized Technology software
provides various simulation methods (continuous, discrete, phasor) and analysis tools.
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Per-Unit System of Units

In this section...

“What Is the Per-Unit System?” on page 1-7

“Example 1: Three-Phase Transformer” on page 1-9

“Example 2: Asynchronous Machine” on page 1-10

“Base Values for Instantaneous Voltage and Current Waveforms” on page 1-11
“Why Use the Per-Unit System Instead of the Standard SI Units?” on page 1-11

What Is the Per-Unit System?

The per-unit system is widely used in the power system industry to express values of
voltages, currents, powers, and impedances of various power equipment. It is typically
used for transformers and AC machines.

For a given quantity (voltage, current, power, impedance, torque, etc.) the per-unit value
is the value related to a base quantity.

base value in p.u. = quantity expressed in SI units

base value

Generally the following two base values are chosen:

* The base power = nominal power of the equipment
* The base voltage = nominal voltage of the equipment

All other base quantities are derived from these two base quantities. Once the base power
and the base voltage are chosen, the base current and the base impedance are
determined by the natural laws of electrical circuits.

base power

base current = —————
base voltage

base voltage _ (base Voltage)2

base impedance = =
base current base power

For a transformer with multiple windings, each having a different nominal voltage, the
same base power is used for all windings (nominal power of the transformer). However,

1-7
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according to the definitions, there are as many base values as windings for voltages,
currents, and impedances.

The saturation characteristic of saturable transformer is given in the form of an
instantaneous current versus instantaneous flux-linkage curve: [il phil; i2 phi2; ..., in
phin].

When the per-unit system is used to specify the transformer R L parameters, the flux
linkage and current in the saturation characteristic must be also specified in pu. The
corresponding base values are

base instantaneous current = (base rms current) x \/5

(base rms voltage) x V2
27 x(base frequency)

base flux linkage =

where current, voltage, and flux linkage are expressed respectively in volts, amperes, and
volt-seconds.

For AC machines, the torque and speed can be also expressed in pu. The following base
quantities are chosen:

* The base speed = synchronous speed
* The base torque = torque corresponding at base power and synchronous speed

base torque = base power (3 phases) in VA

base speed in radians/second

Instead of specifying the rotor inertia in kg*m?, you would generally give the inertia
constant H defined as

_ kinetic energy stored in the rotor at synchronous speed in joules

machine nominal power in VA

li-w2
2

H =
Prnom

The inertia constant is expressed in seconds. For large machines, this constant is around
3-5 seconds. An inertia constant of 3 seconds means that the energy stored in the
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rotating part could supply the nominal load during 3 seconds. For small machines, H is
lower. For example, for a 3-HP motor, it can be 0.5-0.7 seconds.

Example 1: Three-Phase Transformer

Consider, for example, a three-phase two-winding transformer with these manufacturer-

provided, typical parameters:

Nominal power = 300 kVA total for three phases

Nominal frequency = 60 Hz

Winding 1: connected in wye, nominal voltage = 25 kV RMS line-to-line

resistance 0.01 pu, leakage reactance = 0.02 pu

Winding 2: connected in delta, nominal voltage = 600 V RMS line-to-line

resistance 0.01 pu, leakage reactance = 0.02 pu

Magnetizing losses at nominal voltage in % of nominal current:

Resistive 1%, Inductive 1%

The base values for each single-phase transformer are first calculated:

For winding 1:

Base power

300 kVA/3 = 100e3 VA/phase

Base voltage

25 kV/sqrt(3) = 14434 V RMS

Base current

100e3/14434 = 6.928 A RMS

Base impedance

14434/6.928 = 2083 Q

Base resistance

14434/6.928 = 2083 Q

Base inductance

2083/(2*60)= 5.525 H

For

winding 2:

Base power

300 kVA/3 = 100e3 VA

Base voltage

600 V RMS

Base current

100e3/600 = 166.7 A RMS

Base impedance

600/166.7 = 3.60 Q

1-9




1 Getting Started

1-10

Base resistance 600/166.7 = 3.60 Q

Base inductance 3.60/(2m*60) = 0.009549 H

The values of the winding resistances and leakage inductances expressed in SI units are
therefore

» For winding 1: R1= 0.01 * 2083 = 20.83 Q; L1= 0.02%¥5.525 = 0.1105 H
» For winding 2: R2= 0.01 * 3.60 = 0.0360 Q; L2= 0.02*0.009549 = 0.191 mH

For the magnetizing branch, magnetizing losses of 1% resistive and 1% inductive mean a
magnetizing resistance Rm of 100 pu and a magnetizing inductance Lm of 100 pu.
Therefore, the values expressed in SI units referred to winding 1 are

* Rm =100*2083 = 208.3 kQ
* Lm =100%5.525=552.5H

Example 2: Asynchronous Machine

Now consider a three-phase, four-pole Asynchronous Machine block in SI units. It is rated
3 HP 220 V RMS line-to-line, 60 Hz.

The stator and rotor resistance and inductance referred to stator are

e Rs=10.435Q;Ls=2mH
e Rr=0.816 Q; Lr = 2 mH

The mutual inductance is Lm = 69.31 mH. The rotor inertia is J = 0.089 kg.m?.

The base quantities for one phase are calculated as follows:

Base power 3 HP*746VA/3 = 746 VA/phase

Base voltage 220 V/sqrt(3) = 127.0 VRMS

Base current 746/127.0 = 5.874 A RMS

Base impedance 127.0/5.874 = 21.62 Q

Base resistance 127.0/5.874 = 21.62 Q

Base inductance 21.62/(2n*60)= 0.05735 H = 57.35 mH

Base speed 1800 rpm = 1800*(2m)/60 = 188.5 radians/second
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Base torque (three-phase) 746*3/188.5 = 11.87 newton-meters

Using the base values, you can compute the values in per-units.
Rs=0.435/21.62 = 0.0201 pu Ls=2/57.35 = 0.0349 pu

Rr=0.816/21.62 = 0.0377 pu Lr= 2/ 57.35 = 0.0349 pu

Lm = 69.31/57.35 = 1.208 pu

The inertia is calculated from inertia J, synchronous speed, and nominal power.

Log w? %x0.089><(188.5)2

H=2 = =0.7065 seconds
Prnom 3x746

If you open the dialog box of the Asynchronous Machine block in pu units provided in the
Machines library of the Simscape Power Systems Specialized Technology Fundamental
Blocks library, you find that the parameters in pu are the ones calculated.

Base Values for Instantaneous Voltage and Current
Waveforms

When displaying instantaneous voltage and current waveforms on graphs or
oscilloscopes, you normally consider the peak value of the nominal sinusoidal voltage as 1
pu. In other words, the base values used for voltage and currents are the RMS values

given multiplied by v2 .

Why Use the Per-Unit System Instead of the Standard SI
Units?

Here are the main reasons for using the per-unit system:

*  When values are expressed in pu, the comparison of electrical quantities with their
"normal" values is straightforward.

For example, a transient voltage reaching a maximum of 1.42 pu indicates immediately
that this voltage exceeds the nominal value by 42%.

1-11
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The values of impedances expressed in pu stay fairly constant whatever the power and
voltage ratings.

For example, for all transformers in the 3-300 kVA power range, the leakage
reactance varies approximately 0.01-0.03 pu, whereas the winding resistances vary
between 0.01 pu and 0.005 pu, whatever the nominal voltage. For transformers in the
300 kVA to 300 MVA range, the leakage reactance varies approximately 0.03-0.12 pu,
whereas the winding resistances vary between 0.005-0.002 pu.

Similarly, for salient pole synchronous machines, the synchronous reactance Xj is
generally 0.60-1.50 pu, whereas the subtransient reactance X'q is generally 0.20-0.50
pu.

It means that if you do not know the parameters for a 10-kVA transformer, you are not
making a major error by assuming an average value of 0.02 pu for leakage reactances
and 0.0075 pu for winding resistances.

The calculations using the per-unit system are simplified. When all impedances in a
multivoltage power system are expressed on a common power base and on the nominal
voltages of the different subnetworks, the total impedance in pu seen at one bus is
obtained by simply adding all impedances in pu, without considering the transformer
ratios.
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* “Modeling Power Engineering Systems Using Simscape Power Systems Simscape
Components Software” on page 2-2

+ “Essential Power Engineering Modeling Techniques” on page 2-4
* “Three-Phase Ports” on page 2-6
» “Switch Between Physical Signal and Electrical Ports” on page 2-8
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Modeling Power Engineering Systems Using Simscape
Power Systems Simscape Components Software
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In this section...

“Simscape Power Systems Simscape Components Blocks and Ports” on page 2-2
“Machine and Transformer Source Code Examples” on page 2-3

“Plotting and Display Options for Asynchronous and Synchronous Machines” on page 2-
3

“Choosing the Right Simscape Technology” on page 2-3

Simscape Power Systems Simscape Components Blocks and
Ports

Simscape Power Systems Simscape Components blocks are written in the Simscape
language. The blocks are fully compatible with Simscape technology, including the local
solver, code generation, and data logging.

Simscape Power Systems Simscape Components blocks have composite three-phase,
electrical conserving, and mechanical rotational conserving ports. You can use composite
three-phase ports to build models corresponding to single-line diagrams of three-phase
electrical systems. Composite three-phase ports connect to other composite three-phase
ports. Electrical and mechanical rotational conserving ports connect directly to Simscape
Foundation library components and Simscape add-on products such as Simscape
Electronics™. You can use a Phase Splitter block to split a composite three-phase port
into individual electrical conserving ports.

Blocks in the Semiconductors library of Simscape Power Systems Simscape Components
software have an option to switch certain ports between physical signal and electrical
conserving ports. When you select electrical ports, the semiconductor block has the same
ports as the equivalent semiconductor block in Simscape Electronics. Therefore, you can
easily switch semiconductor blocks in your model between the two products. For example,
suppose that you use Simscape Power Systems Simscape Components semiconductor
blocks to model the electronic drive circuit for a three-phase machine but want to
increase the drive circuit fidelity. You can directly replace the semiconductor blocks with
higher-fidelity versions from the Simscape Electronics block library.
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Machine and Transformer Source Code Examples

Simscape Power Systems Simscape Components software comes with Simscape language
source code examples for machines and transformers, which you can view and customize.
To access the example blocks, type ThreePhaseExamples 1ib at the MATLAB
command prompt.

Plotting and Display Options for Asynchronous and
Synchronous Machines

For the Machine Inertia block and the asynchronous and synchronous machine blocks in
Simscape Power Systems Simscape Components software, you can perform some useful
plotting and display actions using the Power Systems menu on the block context menu.
For example, to plot torque versus speed (both in SI units) for the Asynchronous Machine
Wound Rotor (fundamental) block, right-click the block. From the block context menu,
select Power Systems > Plot Torque Speed (SI). The software plots the results in a
figure window.

Using other options on the Power Systems menu, you can plot values in per-unit or
display base parameter values in the MATLAB Command Window. These options enable
you to tune the performance of your three-phase machine quickly.

Choosing the Right Simscape Technology

Simscape Power Systems software includes two different technologies and corresponding
libraries. For a comparison of the two technologies, see “Comparison of Simscape
Components and Specialized Technology” on page 1-6. Choose the Simscape Power
Systems technology most appropriate for your modeling needs and if possible, build your
model using blocks exclusively from that technology. However, if necessary, you can build
a model that uses blocks from both technologies. To do so, use blocks from the Simscape
> Power Systems > Specialized Technology > Interface Elements library to
interface between them.

2-3
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Essential Power Engineering Modeling Techniques
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In this section...

“Overview of Modeling Rules” on page 2-4
“Required Blocks” on page 2-5

Overview of Modeling Rules

Simscape Power Systems Simscape Components models are essentially Simscape block
diagrams refined for modeling three-phase electrical systems. Simscape Power Systems
Simscape Components blocks feature these port types:

Three-phase ports, which connect the phases of a three-phase electrical system
between Simscape Power Systems Simscape Components blocks.

There are two three-phase port types in Simscape Power Systems Simscape
Components blocks, composite and expanded. You can connect a composite three-
phase port only to another composite three-phase port. You can connect the individual
electrical conserving ports of an expanded three-phase port only to other electrical
conserving ports. For more information, see “Three-Phase Ports” on page 2-6.

Electrical and mechanical rotational conserving ports, which connect directly to
Simscape foundation blocks.

Each port type has specific Across and Through variables associated with it. To learn
about the rules to follow when building an electromechanical model, see “Basic
Principles of Modeling Physical Networks” (Simscape).

Physical signal ports, which connect to Simulink blocks through the Simulink-PS
Converter and PS-Simulink Converter blocks from the Simscape Utilities library. These
blocks convert physical signals to and from Simulink mathematical signals.

Keep these rules in mind when using each port type in Simscape Power Systems
Simscape Components blocks.

You can connect physical conserving ports only to other conserving ports of the same
type. Electrical conserving ports in Simscape Power Systems Simscape Components
blocks can connect directly to Simscape Electronics blocks and Simscape electrical
components. Mechanical rotational conserving ports in Simscape Power Systems
Simscape Components blocks can connect directly to Simscape mechanical rotational
components.
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» The physical connection lines that connect conserving ports are nondirectional lines
that carry physical variables (Across and Though variables) rather than signals. You
cannot connect physical conserving ports to Simulink ports or to physical signal ports.

* You can branch physical connection lines. When you do so, directly connected
components share the same Across variables. The value of any Through variable (e.g.,
current or torque) transferred along the physical connection line is divided among the
multiple components connected by the branches.

For each Through variable, the sum of the values flowing into a branch point equals
the sum of the values flowing out.

* You can connect physical signal ports to other physical signal ports using regular
connection lines, similar to Simulink signal connections. These connection lines carry
physical signals between Simscape Power Systems Simscape Components blocks.

* You can connect physical signal ports to Simulink ports through converter blocks. Use
the Simulink-PS Converter block to connect Simulink outports to physical signal
inports. Use the PS-Simulink Converter block to connect physical signal outports to
Simulink inports.

+ Unlike Simulink signals, physical signals can have units. In Simscape Power Systems
Simscape Components block dialog boxes, you can specify the units along with the
parameter values, where appropriate. Use the converter blocks to associate units with
an input signal and to specify the desired output signal units.

For an example of these rules applied to an electromechanical model, see Three-Phase
Asynchronous Machine Starting.

Required Blocks

Each topologically distinct physical network in a diagram requires exactly one Solver
Configuration block from the Simscape Utilities library. The Solver Configuration block
specifies global environment information for simulation and provides parameters for the
solver that your model needs for simulation.

Each electrical network requires an Electrical Reference block. This block establishes the
electrical ground for the circuit. Networks with electromechanical blocks also require a
Mechanical Rotational Reference block. For more information about using reference
blocks, see “Grounding Rules” (Simscape).
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Three-Phase Ports
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In this section...

“About Three-Phase Ports” on page 2-6

“Expand and Collapse Three-Phase Ports on a Block” on page 2-7

About Three-Phase Ports

In Simscape Power Systems Simscape Components software, you can connect the phases
of a three-phase system between blocks using two types of port.

* Composite three-phase port
* Expanded three-phase port

Composite three-phase ports represent three individual electrical conserving ports with a
single block port. You can use composite three-phase ports to build models that
correspond to single-line diagrams of three-phase electrical systems. Instead of explicitly
connecting each phase of the three-phase system between blocks, you connect all three
phases using a single port. You can connect composite three-phase ports only to other
composite three-phase ports.

Expanded three-phase ports represent the individual phases of a three-phase system
using three separate electrical conserving ports. You individually connect each phase of
the three-phase system between blocks. Electrical conserving ports can connect directly
to electrical components from the Simscape and Simscape Electronics libraries.

Composite three-phase ports produce results with the same fidelity as expanded three-
phase ports. Both connection methods consider instantaneous phase voltages and
currents and are suitable for modeling balanced and unbalanced three-phase electrical
power systems. Each electrical conserving port in an expanded three-phase port has a
Through variable of scalar current and an Across variable of scalar voltage. For a
composite three-phase port, the Through variable is a three-element current, and the
Across variable is a three-element voltage.

You can use the Phase Splitter block to expand a composite three-phase port into separate
electrical conserving ports. The separate electrical ports can then connect to Simscape
and Simscape Electronics electrical components.

The figure shows two simple circuits that contrast the composite and expanded
connection methods. The two circuits produce the same results.



Three-Phase Ports
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The top circuit uses a Voltage Source block with a composite three-phase port ~. The
bottom circuit uses a Voltage Source block with expanded electrical conserving ports a, b,
and c. In each circuit, the instantaneous phase voltages and currents are the same.

Expand and Collapse Three-Phase Ports on a Block

Simscape Power Systems Simscape Components blocks that have composite three-phase
ports have an option to switch between composite and expanded ports.

* Right-click the block. On the Simscape block choices context menu, select
Expanded three-phase ports or Composite three-phase ports.

For blocks with a single composite port ~, the expanded electrical ports are labeled a,

b, and c. For blocks with more than one composite port ~1 and ~2, the expanded
electrical ports are labeled al, bl, cl1 and a2, b2, c2.
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Switch Between Physical Signal and Electrical Ports

2-8

Some Simscape Power Systems Simscape Components blocks have an option to switch
certain ports between physical signal and electrical conserving ports. An electrical
conserving port is a Simscape physical conserving port that has a Through variable of
current and an Across variable of voltage. For a comparison of Simscape physical signal
and physical conserving ports, see “Connector Ports and Connection Lines” (Simscape).

* Right-click the block. On the Simscape block choices context menu, select a variant
that includes an Electrical control port or PS control port.

The block connection port switches between & (electrical conserving port) and >
(physical signal port).
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* “Build and Simulate Composite Resistive and Reactive Three-Phase Models”
on page 3-2

* “Create and Simulate Expanded Balanced and Unbalanced Three-Phase Models”
on page 3-9
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Build and Simulate Composite Resistive and Reactive
Three-Phase Models

3-2

In this section...

“Select System Component Blocks” on page 3-2
“Specify Simulation Parameters” on page 3-4
“Load Impedance Parameters” on page 3-5
“Specify Display Parameters” on page 3-5
“Save and Simulate the Model” on page 3-6

“Analyze the Resistive Three-Phase Model Simulation Results” on page 3-6
“Create and Simulate a Reactive Three-Phase Load” on page 3-6
“Analyze the Reactive Three-Phase Model Simulation Results” on page 3-7

This tutorial shows how to build a Simscape Power Systems Simscape Components model.
The model simulates the behavior of a three-phase AC voltage source driving a simple

load.

To see the completed model, click Simple Three-Phase Model.

Select System Component Blocks

1 Open a blank model.
2 Add these blocks to the model.

Block Purpose Library Path Quan
tity
Scope Display phase voltages and Simulink > Sinks 1
currents for the three-phase
system.
Electrical Provide the ground connection |Simscape > Foundation |1
Reference |for electrical conserving ports. |Library > Electrical >
Electrical Elements
PS-Simulink |Convert the physical signals to|Simscape > Utilities 2
Converter |a Simulink signals.



matlab:open_system('pe_three_phase_simple_model');
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Block Purpose Library Path Quan
tity
Solver Define solver settings that Simscape > Utilities 1
Configuratio |apply to all physical modeling
n blocks.
Grounded |Provide an electrical ground |Simscape > Power 2
Neutral connection for each phase of |Systems > Simscape
the three-phase system. Components >
Connections
RLC Model the resistive, inductive, |Simscape > Power 1
and capacitive properties of |Systems > Simscape
the three-phase load. Components > Passive
Devices
Current Convert the electrical current |Simscape > Power 1
Sensor flowing in each phase of the |Systems > Simscape
three-phase load into a Components > Sensors
physical signal proportional to
that current.
Phase Convert the voltage across Simscape > Power 1
Voltage each phase of the three-phase |Systems > Simscape
Sensor system into a physical signal |Components > Sensors
proportional to that voltage.
Voltage Provide an ideal three-phase |Simscape > Power 1
Source voltage source that maintains |Systems > Simscape
a sinusoidal voltage across its |Components > Sources
output terminals, regardless
of the current flowing in the
source.

3 Add a second input port to the Scope block.

a  Right-click the Scope block.
b From the context menu, select Signals & Ports > Number of Input Ports > 2

4  Connect the blocks as shown.
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Converter

={PS 5

P3-Simulink
Converter1

PS5
PE-Simulink

Scope

Solver
Canfiguration
Voltage Source Current Sensor

RLC

i
—— Electrical Reference Grounded Neutrall

Phase Violtage Sensor

Grounded Neutral

5 Save the model using the name simplethreephasemodel.

The blocks in this model use composite three-phase ports. For more information, see
“Three-Phase Ports” on page 2-6.

Specify Simulation Parameters

As with Simscape models, you must include a Solver Configuration block in each
topologically distinct physical network. This model has a single physical network, so use
one Solver Configuration block.

1 In the Solver Configuration block, select Use local solver and set Sample time to
0.0001.

In Simscape-based models, the local solver is a sample-based solver that represents
physical network states as discrete states. For most Simscape Power Systems
Simscape Components models, the local solver is an appropriate first choice. The
solver updates block states once per simulation time step, as determined by Sample
time. For simulation of a 60-Hz AC system, an appropriate sample time is a value in
the order of 1e-4. For more information on solver options, see Solver Configuration.

If you prefer to use a continuous solver instead of a discrete solver, clear the Use
local solver check box in the Solver Configuration block. The simulation then uses
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the Simulink solver specified in the model configuration parameters (Simulation >
Model Configuration Parameters). For Simscape Power Systems Simscape
Components models, an appropriate solver choice is the moderately stiff solver
ode23t. For a 60-Hz AC system, specify a value for Max step size in the order of
le-4. For more information, see “Variable-Step Continuous Explicit Solvers”
(Simulink).

2 In the Simulink Editor, set the simulation Stop time to 0. 1.

Load Impedance Parameters

The RLC block models resistive, inductive, and capacitive characteristics of the three-
phase load. Using the Component structure parameter, you can specify a series or
parallel combination of resistance, inductance, and capacitance.

In the RLC block, the defaults are:

* Component structure — R.
* Resistance — 1 Q.

Using the default Component structure value, R, models a three-phase load that is
purely resistive in nature. The resistance in each phase is 1 Q.

Specify Display Parameters

Sensor blocks in the model convert the current and voltage in each phase of the three-
phase system to proportional physical signals. PS-Simulink Converter blocks convert the
physical signals into Simulink signals for the Scope block to display.

1 Of these three types of blocks, only the converter blocks have parameters. For this
example:

* Set Output signal unit of the PS-Simulink Converter block to A. This setting
ensures that the block outputs a signal with the same magnitude as the ampere
signal that enters it.

* Set Output signal unit of the PS-Simulink Converter1 block to V. This setting
ensures that the block outputs a signal with the same magnitude as the voltage
signal that enters it.

2 Label the input signals to the Scope block. Double-click each line, and type the
appropriate label, Currents or Voltages, as shown in the model graphic.
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You are ready to simulate the model and analyze the results.

Save and Simulate the Model

1  Save the model.
2 Simulate the model. In the menu bar of the Simulink Explorer, click the Run button.

Analyze the Resistive Three-Phase Model Simulation Results
1 View the phase currents and voltages. Double-click the Scope block.

To scale the scope axes to the data, click the Autoscale button E

In this simulation, the Component structure parameter of the RLC block specifies that
the electrical characteristics of the three-phase load are purely resistive. Therefore, for
each phase of the three-phase system, the voltage and current remain in phase with each
other. Because the resistance in each phase is 1 Q, the magnitude of the phase voltage is
equal to the magnitude of the phase current.

Create and Simulate a Reactive Three-Phase Load

This procedure shows you how to modify the model to create a reactive load. A reactive
load has inductive or capacitive characteristics.
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1  Save this version of the model using the name
simplethreephasemodel reactive.

2 Inthe RLC block, set:
+ Component structure to Series RL
* Inductance to 0.002

3 Simulate the model.

Analyze the Reactive Three-Phase Model Simulation Results

View the simulation results. Autoscale the scope axes.

Examine the results in closer detail. For example, click the Zoom button and
drag a box over the first third of one of the plots.

The electrical characteristics of three-phase load are no longer purely resistive.
Because the load has an inductive characteristic, the current flowing in each phase
lags the voltage.
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See Also

Related Examples

. “Create and Simulate Expanded Balanced and Unbalanced Three-Phase Models” on
page 3-9
. “Essential Power Engineering Modeling Techniques” on page 2-4
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Create and Simulate Expanded Balanced and
Unbalanced Three-Phase Models

This procedure shows you how to modify a model that you built in “Build and Simulate
Composite Resistive and Reactive Three-Phase Models” on page 3-2 to create:

* A three-phase load expanded into individual phases

* An expanded three-phase load that does not have equal resistance in each phase

In this procedure, you change the original model and save the changes as new models.
You then simulate the new models and analyze the results.

Create an Expanded Balanced Three-Phase Model

Open Simple Three-Phase Model.
Delete the RLC block.

Drag two copies of the Phase Splitter block into the model from the Simscape >
Power Systems > Simscape Components > Connections library.

4  Flip one of the Phase Splitter blocks horizontally. Right-click the block and select
Rotate & Flip > Flip Block > Left-Right.

5 Drag a Resistor element into the model from the Simscape > Foundation Library >
Electrical > Electrical Elements library.

6 To create space for more components, hide the Resistor element label. Right-click the
resistor and select Format > Show Block Name to clear this option.

Make two more copies of the Resistor element.
Connect the components as shown.
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9 Save this version of the modified model using the name
simplethreephasemodel expanded balanced.

This model name reflects that the load previously modeled by the RLC block is now
expanded into individual phases. The load is still balanced, that is, there is equal
resistance in each phase.

Create an Expanded Unbalanced Three-Phase Model

1 Unbalance the load by changing the resistance in one phase. Double-click one of the
resistor elements. Change Resistance to 2.

2 Save this version of the modified model using the name
simplethreephasemodel expanded unbalanced.

This model name reflects that the three-phase load previously modeled by the RLC
block is expanded into individual phases. The load is unbalanced, that is, the
resistance in one of the phases is higher than in the other two.

Simulate the Models and Analyze Results

1 Simulate the simplethreephasemodel expanded balanced model. In the menu
bar of the Simulink Explorer, click the Run button.
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View the simulation results. Double-click the Scope block.

To scale the scope axes to the data, click the Autoscale button E

In “Build and Simulate Composite Resistive and Reactive Three-Phase Models” on
page 3-2, the Component structure parameter of the RLC block specifies that the
three-phase load is purely resistive. In this version of the model, the load is expanded
into an individual resistive element for each phase, but the resistance in each phase
is unchanged. For each phase of the three-phase system, the voltage and current
remain in phase with each other. Because the resistance in each phase is 1 Q, the
magnitude of the phase voltage is equal to the magnitude of the phase current.

Comparing these results with the results for the three-phase resistive model shows
that a block with composite three-phase ports (the RLC block in the original model),
produces results with the same fidelity as that of expanded phases.

Open the simplethreephasemodel expanded unbalanced model.
Simulate the model. Autoscale the scope axes.
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In this version of the model, one phase of the three-phase load has twice the
resistance of the other two. Therefore, half as much current flows in that phase, as
the second plot shows. However, because the load remains purely resistive, the
voltage and current remain in phase with each other.

See Also

Related Examples

. “Build and Simulate Composite Resistive and Reactive Three-Phase Models” on page
3-2
. “Essential Power Engineering Modeling Techniques” on page 2-4
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* “Machine Parameterization” on page 4-2

* “Per-Unit Conversion for Machine Parameters” on page 4-4

* “Machine Plotting and Display Options” on page 4-6

» “Initialize Synchronous Machines and Controllers” on page 4-8
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Machine Parameterization

4-2

In Simscape Power Systems Simscape Components software, asynchronous machines are
parameterized using fundamental parameters. Each synchronous machine is
parameterized using standard or fundamental parameters.

Machine fundamental parameters include the values of inductances and resistances of the
stator and rotor d- and g-axis equivalent circuits. These parameters fully specify the
electrical characteristics of the machine, but you cannot determine them directly from
machine test responses. Hence, it is more common to parameterize a synchronous
machine using a standard parameter set. You can obtain the standard parameters by
observing responses at the machine terminals with suitable tests scenarios.

You can tell the parameter set a block uses because the block name includes the
parameter set name, e.g. Asynchronous Machine Squirrel Cage (fundamental). The
parameters you can set in the block dialog box correspond to the parameterization type.

If a machine block has standard and fundamental variants, base your block choice on the
parameters you are most familiar with or you have available. Standard block variants use
classical equations to convert standard parameter values that you enter to fundamental
parameter values for use at run time.

If a machine block has an SI and a per-unit variant, base your block choice on the
parameters you have available. For machine blocks that are SI variants, you enter the
number of pole pairs and the SI values for the nominal voltage, power, and frequency on
the main tab of the dialog box. You also enter SI values for the resistance and reactance
parameters on the impedance tab, and for the magnetic flux linkage parameters on the
initial condition tab. The block uses classical equations to calculate per-unit base values
from the parameters on the main tab. It expresses the resistance, inductance, and
magnetic flux linkage parameters as per-unit ratios of the SI values (resistance,
reactance, and magnetic flux linkage) and the base values for use at run time.

The field circuit and rotational ports of machine blocks use SI units. However, the pu
measurement port of machine blocks outputs a vector of physical signals in per-unit.



See Also

See Also

More About
. “Per-Unit System of Units” on page 1-7
. “Per-Unit Conversion for Machine Parameters” on page 4-4
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Per-Unit Conversion for Machine Parameters

In this section...

“Impedance Conversion Equations” on page 4-4
“Magnetic Flux Linkage Conversion Equations” on page 4-4

Impedance Conversion Equations

For machine impedance parameters (resistance, inductance, and reactance), the
relationships between SI and per-unit values are defined by these equations:

R
R= (SI)
Rbase
X
L=x =280
Xbase
where:

* R is the resistance, expressed in Q.

* Ry is the per-unit base resistance, expressed in Q.
* R s the per-unit resistance.

* X 1s the reactance, expressed in Q.

*  Xpse 1S the per-unit base reactance, expressed in Q.
* X s the per-unit reactance.

* L is the per-unit inductance.

Magnetic Flux Linkage Conversion Equations

For machine magnetic flux linkage parameters, the relationship between SI and per-unit
values is defined by

Y (si)
Y=—
Yhase
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where:

* sy is the magnetic flux linkage, expressed in Wh.
*  Wpwe iS the per-unit base magnetic flux linkage, expressed in Wb.
* y is the per-unit magnetic flux linkage.

See Also

More About
. “Per-Unit System of Units” on page 1-7



4 Modeling Machines

Machine Plotting and Display Options
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Use the Power Systems menu on the block context menu to perform plotting and display
actions for certain blocks in the Simscape Power Systems Simscape Components
Machines sublibrary. For example, you can plot torque versus speed for the Asynchronous
Machine Wound Rotor block, either in SI or per-unit units.

Using other options on the Power Systems menu, you can display values in per-unit or
display base parameter values in the MATLAB Command Window. These options enable
you to initialize and tune your three-phase machine quickly.

Asynchronous Machine Options
* Display Base Values displays the machine per-unit base values in the MATLAB
Command Window.

* Plot Torque Speed (SI) plots torque versus speed (both measured in SI units) in a
MATLAB figure window using the present machine parameters.

* Plot Torque Speed (pu) plots torque versus speed (both measured in per-unit) in a
MATLAB figure window using the present machine parameters.

Synchronous Machine Options

All synchronous machine block context menus contain these display options:
* Display Base Values displays the machine per-unit base values in the MATLAB
Command Window.

* Display Associated Base Values displays associated per-unit base values in the
MATLAB Command Window.

* Display Associated Initial Conditions displays associated initial conditions in the
MATLAB Command Window.

The round rotor and salient pole synchronous machine block context menus also contain
these plotting options;

* Plot Open-Circuit Saturation (pu) plots air-gap voltage, V4, versus field current, i,
both measured in per-unit, in a MATLAB figure window. The plot contains three traces:

* Unsaturated: Stator d-axis mutual inductance (unsaturated), Ladu you specify
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* Saturated: Per-unit open-circuit lookup table (Vag versus ifd) you specify

* Derived: Open-circuit lookup table (per-unit) derived from the Per-unit open-
circuit lookup table (Vag versus ifd) you specify. This data is used to calculate
the saturation factor, K, versus magnetic flux linkage, y,, characteristic.

* Plot Saturation Factor (pu) plots saturation factor, K, versus magnetic flux linkage,
V., both measured in per-unit, in a MATLAB figure window using the present machine
parameters. This value is derived from parameters you specify:

* Stator d-axis mutual inductance (unsaturated), Ladu
* Per-unit field current saturation data, ifd
* Per-unit air-gap voltage saturation data, Vag

Machine Inertia Block Options

For the Machine Inertia block, you can display the inertia parameters and base values
using the Power Systems menu on the block context menu. The block displays parameter
values in the MATLAB Command Window.
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Initialize Synchronous Machines and Controllers
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In Simscape Power Systems Simscape Components software, you can specify steady-state
power and voltage values for a synchronous machine. Based on the values you specify, the
machine block calculates the initial field circuit and rotational input values required to
achieve this steady state. Starting a machine at steady state prevents undesired transient
effects in your simulation.

Calculate the required power and voltage characteristics of your load circuit.

In the Initial Conditions tab of the dialog box, set Specify initialization by to
Electrical power and voltage output.

3 Enter the required power and voltage values and click OK.

Right-click the machine block and select Power Systems > Display Associated
Initial Conditions.

Simscape Power Systems calculates the field circuit and rotational port values
required to start the machine in steady state and displays them in the MATLAB
Command Window.

5 Use these values to input parameters to the blocks connected to the field circuit and
rotational ports of the synchronous machine.

Note If you set Specify initialization by to Mechanical and magnetic states,
Simulink does not calculate the associated initial conditions fro the machine.




Customization

* “Build Custom Blocks Using the Three-Phase Electrical Domain” on page 5-2
* “Customizing Machine Models” on page 5-4
* “Custom Synchronous Machine” on page 5-6
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Build Custom Blocks Using the Three-Phase Electrical
Domain

5-2

In addition to the Simscape Foundation domains, Simscape Power Systems Simscape
Components software contains a three-phase electrical domain. You can use this domain
to develop your own custom three-phase blocks using Simscape language.

The three-phase electrical domain declaration is shown.

domain electrical
% Three-Phase Electrical Domain

% Copyright 2012-2013 The MathWorks, Inc.

parameters
Temperature = { 300.15 , 'K' }; % Circuit temperature
GMIN = { le-12 , '1/0hm' }; % Minimum conductance, GMIN
end
variables
V={[0007], 'V'};
end

variables(Balancing = true)
I={[0001], 'A"};
end

end

It contains the following variables and parameters:

* Across variable V (voltage), declared as a three-element row vector, in volts

* Through variable I (current), declared as a three-element row vector, in amperes
* Parameter Temperature, specifying the circuit temperature

» Parameter GMIN, specifying minimum conductance

To refer to this domain in your custom component declarations, use the following syntax:

pe.electrical.three phase.electrical
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See Also

Related Examples

. “Custom Synchronous Machine” on page 5-6
More About

. “Customizing Machine Models” on page 5-4
. “Custom Components” (Simscape)

. “Foundation Domains” (Simscape)
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Customizing Machine Models

The ThreePhaseExamples library, included in the product examples, contains the
following custom three-phase components:

* Permanent Magnet Synchronous Motor
* Synchronous Machine

* Synchronous Machine (simplified)

» Zigzag Transformer

You can use these simplified example models to write your own machine and transformer
component files.

To open the custom library, at the MATLAB command prompt, type
ThreePhaseExamples 1lib. Double-click any block in the library to open its dialog box,
and then click the Source code link in the block dialog box to open the Simscape source
file for this block in the MATLAB Editor.

To customize the block for your application, edit the source file and save it in a package
directory.

For example, you can create a folder called +MyMachines and save the source files for
your customized machines in this folder. Create this folder in your working directory, or in
another directory that is on the MATLAB path. Running the ssc_build command on this
package generates the MyMachines 1ib library model. This library contains all your
custom machine blocks and is located in the same directory where you have created the
+MyMachines folder. Open the MyMachines 1ib library by double-clicking it or by
typing its name at the MATLAB command prompt.

For more information on packaging and deploying Simscape component files, see
“Building Custom Block Libraries” (Simscape).

Things to keep in mind when writing component files:

* Ifyou create a custom component by modifying an existing one, do not forget to
change the name of the component and the name of the resulting block.

* The component name must be the same as the name of the Simscape file. For example,
if you plan to save your component in a file called MyComponent . ssc, change the
declaration line in the file:

component MyComponent



Customizing Machine Models

The comment line immediately following the component declaration (that is, the first
line beginning with the % character) defines the name of the block, as it appears in the
custom library next to the block icon and at the top of the block dialog box. If you do
not specify this comment, then the component name serves as the block name. The
block name must be unique within the subpackage (sublibrary) where it resides.

Additional comments, below the line specifying the block name, are interpreted as the
block description. You do not have to modify them when copying an existing file, but if
you change the way the component works, it makes sense to reflect the change in the
block description. The block description is for informational purposes only.

When modifying component equations, if you introduce additional terms, make sure to
add the appropriate variables or parameters to the component declaration section. For
example, if you add zero-sequence dynamics to the component equations, declare an
additional parameter for stator zero-sequence inductance, L0, and an additional
variable for the initial stator zero-sequence magnetic flux linkage.

The “Custom Synchronous Machine” on page 5-6 tutorial shows how you can modify
the Synchronous Machine component file and customize it for use in your applications.
For more information on writing customized component files, see “Custom Components”
(Simscape).
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Custom Synchronous Machine

The ThreePhaseExamples library, included in the product examples, contains simplified
example models that you can use to write your own machine and transformer component
files. The Synchronous Machine component in the ThreePhaseExamples library is similar
to the Synchronous Machine Round Rotor (fundamental) block, but its equations have
been simplified to omit zero-sequence dynamics. The Synchronous Machine block is
therefore suitable for balanced operation only.

This example shows how you can further simplify the component file and make a custom
machine block that does not account for the stator rate of change of flux.

1 In your working directory, create a folder called +MyMachines. This folder will
contain the source files for your customized machines.

2 To open the library of simplified component examples, at the MATLAB command
prompt, type:

ThreePhaseExamples 1lib



Custom Synchronous Machine
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3 Double-click the Synchronous Machine block.
In the block dialog box, click the Source code link.
The Simscape source file for this block opens in the MATLAB Editor.
5 Change the name of the component, the name of the block, and the block description

0® 0% o° o° o° o°

component sm

by replacing these lines of the file:

Synchronous Machine
Synchronous machine (SM) with a round rotor parameterized using

fundamental per-unit parameters.

The SM model includes field and

damper windings on the d-axis and two damper windings on the g-axis.
The stator d.psi/dt terms are included, as is the effect of speed
variation on the stator voltages. The defining equations are

5-7




5 Customization

simplified by omitting the zero-sequence dynamics: the model is
suitable for balanced operation.

% Copyright 2012-2014 The MathWorks, Inc.
with:
component sml

% Simplified Synchronous Machine
% This synchronous machine does not include the stator d.psi/dt terms.

To remove the stator rate of change of flux terms, scroll down to the equations
section and modify the stator voltage equations from:

% Per unit stator voltage equations

pu_ed == oneOverOmega*pu psid.der - pu_psig*pu_velocity - Ra*pu_id;
pu_eq == oneOverOmega*pu psiq.der + pu_psid*pu_velocity - Ra*pu iq;
to:

% Per unit stator voltage equations
pu ed == -pu_psig*pu_velocity - Ra*pu_id;
pu_eq == pu_psid*pu velocity - Ra*pu iq;

Save the file in the +MyMachines folder as sml. ssc. The name of the Simscape file
must match the component name.

To generate the custom library containing the new block, at the MATLAB command
prompt, type:

ssc_build

This command generates the MyMachines 1ib library model in your working
directory.

To open the custom library, at the MATLAB command prompt, type:
MyMachines lib

The library contains the Simplified Synchronous Machine block, which you can now
use in your models.



See Also

3 Library: MyMac... - m}

File Edit View Display Diagram

x

»

R R = | ”EE”@'

MyMachines_lib

® |[Pu|MyMachines_lib -

G’l Eéﬁmsdlpéﬁ
pu_Mt

IE' E smi .

Simplified

Synchronous Machine

]

U

7]

Ready 100%

ssc_build

Related Examples

. “Build Custom Blocks Using the Three-Phase Electrical Domain” on page 5-2

. “Building Custom Block Libraries” (Simscape)

More About

. “Customizing Machine Models” on page 5-4

. “Custom Components” (Simscape)

. “Customizing the Block Name and Appearance” (Simscape)
. “Component Equations” (Simscape)
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Tune an Electric Drive

Tn raf

In this section...

“Cascade Control Structure” on page 6-2
“Equations for PI Tuning Using the Pole Placement Method” on page 6-2
“Equations for DC Motor Controller Tuning” on page 6-6

“Tune the Electric Drive in the Example Model” on page 6-8

This example shows how to tune an electric drive using a cascade control structure.

Cascade Control Structure

The figure shows a feedback control loop that uses a cascade control structure. The outer
speed-control loop is slower acting than the inner current-control loop.

Speed laref Current Vg n

S — = DC Motor .

6-2

Control Control
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Equations for Pl Tuning Using the Pole Placement Method

To satisfy the required control performance for a simple discrete plant model, G¢(z), use
a closed loop PI control system Gpi(z!). The transient performance can be expressed in
terms of the overshoot. The overshoot decreases relative to the damping factor:

—ﬂf

o=e JI=¢*
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where,

* 0 is overshoot.
» ¢ isthe damping factor.

The response time, t,, depends on the damping and the natural frequency, w,, such that:

. IfE<0.7,

4
&

. If£207,

t

N

The general workflow for designing a PI controller for a first-order system is:

1 Discretize the plant model using the zero-order hold (ZOH) discretization method.
That is, given that the first-order equation representing the plant is

Gs)=—m

T, s+1

where,

* K, is the first-order gain.
* T, is time constant of the first-order system.

Setting

1

)

1=z

271T3

yields the discrete plant model,

6-3



6 Control

6-4

whereT, is sample time for the discrete-time controller.

Write a discrete-time representation for the PI controller using the same transform.
For

1

N

setting
o= 1-z7!
i%ﬂl

yields the discrete controller model,

-1 -1
Kp+ (KT, —Kp)z _do*ac

Gpr ™h= ] 7
1-z 1-z

Combining the discrete equations for the plant and the controller yields the closed
loop transfer function for the system,

-1 )
gz +qibiz

Go(z )= ,
1+ (a; ~1+qoby )z +(~a; + by )27

The denominator of the transfer function is the characteristic polynomial. That is,

PCO (Z_l) = 1 + (al _1 + qObl) Z_l + (_al +q1b1) 2_2.
The characteristic polynomial for achieving the required performance is defined as

-1 -1 -2
Pcd(Z ):1+a12 +a22 5
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where,

0oy =277 cos (a)nTS 1-&2 j

o, = 2501,

To determine the controller parameters, set the characteristic polynomial for the
system equal to the characteristic polynomial for the required performance. If

Py =Puh),
then

oy =a; —1+¢qyb
and

0y =—a;+qb.

Solving for q, and q; yields

o —q +1
q0 =—
bl
and
OohH +a
a=—7 -
h

Therefore, the general equations for the proportional and integral control parameters
for the first-order system are

Kp=q
and
B q +Kp

=

N
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Equations for DC Motor Controller Tuning

Assuming that, for the system in the example model, K, = K;, the simplified mathematical
equations for voltage and torque of the DC motor are

di .
v, =1L, d—?+Raza +K,»

and

do .
Te :JME"F Bmw+T[011d = Kbla’

where:

* v, is the armature voltage.

* i, is the armature current.

* L, is the armature inductance.

* R, is the armature resistance.

* w is the rotor angular velocity

* T, is the motor torque.

* T is the load torque.

* J, is the rotor moment of inertia.

* B,is the viscous friction coefficient.
* K, is a constant of proportionality.

To tune the current controller, assume that the model is linear, that is, that the back
electromotive force, as represented by K,w, is negligible. This assumption allows for an
approximation of the plant model using this first-order Laplace equation:

1
R
[aJs—i-l
R,

Given the system requirements, you can now solve for Kp and K;. The requirements for the
current controller in the example model are:
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* Sample time, T,= 1 ms.
* Overshoot, 0 = 5%.
* Response time, . = 0.11 s.

Therefore, the proportional and integral parameters for the current controller are:

Kp =17.709.
K, = 455.1491.

To tune the speed controller, approximate the plant model with a simple model. First
assume that the inner loop is much faster than the outer loop. Also assume that there is
no steady-state error. These assumptions allow for the use a first-order system by
considering a transfer function of 1 for the inner current loop.

To output rotational velocity in revolutions per minute, the transfer function is multiplied
by a factor of 30/m. To take as control input the armature current instead of the motor
torque, the transfer function is multiplied by the proportionality constant, K. The
resulting approximation for the outer-loop plant model is

30K,
nB,

[Jm ]s +1
Bm

The speed controller has the same sample time and overshoot requirements as the
current controller, but the response time is slower, such that:

G,(s) =

* Sample time T,= 1 ms.
* Overshoot 0 = 5%.
* Response time t. = 0.50 s.

Therefore, the proportional and integral parameters for the speed controller are:
* Kp=0.0045

* K, =0.0405
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Tune the Electric Drive in the Example Model

1 Explore the models of the DC motor and the cascaded controller.

a Open the model. At the MATLAB command prompt, enter

model = 'pe dc motor control'
open_system(model)

rpmReq
Control
» G A a: PS5
fg=0 2+ - v+ R R R2 €|c -—
- TlLoad
Meas | Sensor o
C OC Valtage Meas 1+ ;orque
_) Source , ource
Z- W- c
i wr

[Four Quadrant Chopper DC Motor

DC Motor Control

rpmiRe |:2>—i-

This example shows a cascade speed-control structure for a DC motor. A PVWM rpm Al ] v Irpm] |
controlled four-gquadrant Chopper is used to feed the DC motor. The Control
subsystem includes the outer speed-control loop. the inner current-control loop, and
the PWM generation. The total simulation time (t) is 4 seconds. At t = 1.5 seconds, the
load torque increases. Att= 2.5 seconds, the reference speed is changed from 1000 !
rpm to 2000 rpm.

1. Edit associated parameterization script.

2. Explore simulation results using sscexplore.

3. Learn more about this example.

b  The Control subsystem contains the model of the cascaded control system built

using blocks from the Simulink library.
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Slew rate 2000rpm/s

™

(=]

u (:; —»=
windup_dif
\Mn:lup ::Ilf
PIRPM
@{ PI Current PWM Generation

2

S

¢ The DC Motor subsystem contains a simple DC motor model built using blocks

from the Simscape library.

@ e e
W
N Ra La '
Rotational o
C:) - Electromechanical Friction
Converter &}
&)
2o
W

d  The Four Quadrant Chopper subsystem contains four IGBT blocks. When the

Imertia

input voltage exceeds the threshold of 0.5V, the IGBT blocks behave like linear
diodes with a forward-voltage of 0.8 V and a resistance of 1e-4 ohm. When the
threshold voltage is not exceeded, the IGBT blocks act like linear resistors with

an off-state conductance of 1e-5 1/ohm.
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G

*P—“@i

2 Simulate the model.

sim(model)
3 View the results. Open the Scope block.
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Armature current [A]

Motor torque [M*m]

At 1.5 seconds, there is a load torque that results in a steady-state error.

4 Tune the DC motor controller. The pe _getDCMotorFirstOrderPIParams function

calculates the proportional gain, Kp, and the integral gain, K}, for the first-order
system in this example.

The function syntax is [Kp, Ki] = getParamPI(Km,Tm,Ts,sigma,tr).

The input arguments for the function are the system parameters and the
requirements for the controller:

* Km is the first-order gain.
* Tmis the time constant of the first-order system.

* T, is the sample time for the discrete-time controller.
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sigma is the desired maximum overshoot, g.
t, is the desired response time.

To examine the equations in the function, enter

edit pe getDCMotorFirstOrderPIParams

To calculate the controller parameters using the function, save these system
parameters to the workspace:

Ra=4.67; % [0hm]
La=170e-3; % [H]
Bm=47.3e-6; % [N*m/(rad/s)]
Im=42.6e-6; % [Kg*m~2]
Kb=14.7e-3; % [V/(rad/s)]
Tsc=le-3; % [s]

Calculate the parameters for tuning the current controller as a function of the
parameters and requirements for the inner controller:

* Km=1/Ra.

* Tm= La/Ra.

e Ts=Tsc.

* sigma=0.05.
e Tr=0.11.

[Kp_i, Ki_i] = pe_getDCMotorFirstOrderPIParams(1/Ra,La/Ra,Tsc,0.05,0.11)
Kp i =

7.7099

Ki i =
455.1491

The gain parameters for the current controller are saved to the workspace.

Calculate the parameters for tuning the speed controller based on the
parameters and requirements for the outer controller:

« Km=Kb*(30/pi).
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* Tm = Jm/Ra.

* Ts=Tsc.

* sigma=0.05.
* Tr=0.5.

[Kp_n, Ki n] = pe getDCMotorFirstOrderPIParams ((Kb*(30/pi))/Bm,Jm/Bm,Tsc,0.05,0.5)

Kp n =

0.0045

Kin =
0.0405

The gain parameters for the speed controller are saved to the workspace.
Simulate the model using the saved gain parameters for the speed and controllers.

sim(model)
View the results. Open the Scope block.
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Armature current [A]

Motor torque [M*m]

There is slightly more overshoot, however, the controller responds much faster to the load
torque change.

See Also

Inertia | Rotational Electromechanical Converter | Rotational Friction

Related Examples
. “DC Motor Control”
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Simulation and Analysis of Power
Engineering Systems

* “Simulating Power Engineering Systems” on page 7-2

+ “Examine the Simulation Data-Logging Configuration of a Model” on page 7-3
» “Simulate Thermal Losses in Semiconductors” on page 7-5

* “Perform a Power-Loss Analysis” on page 7-16

* “Choose a Simscape Power Systems Function for an Offline Harmonic Analysis”
on page 7-25

» “Perform an Online Harmonic Analysis Using the Simscape Spectrum Analyzer Block”
on page 7-29

* “Optimize Block Settings for Simulations that Use the Partitioning Solver”
on page 7-38

* “Prepare Simscape Power Systems Models for Real-Time Simulation Using Simscape
Checks” on page 7-49

» “Phasor-Mode Simulation in Simscape Components” on page 7-51
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Simulating Power Engineering Systems

7-2

Simscape Power Systems Simscape Components models are Simscape block diagrams
refined for modeling and simulating three-phase electrical power systems. Therefore,
Simscape Power Systems Simscape Components and Simscape simulations behave in the
same way. In addition, Simscape techniques for simulation setup and troubleshooting
apply to Simscape Power Systems Simscape Components models.

To learn about:
* The simulation behavior of Simscape models, see “How Simscape Simulation Works”
(Simscape).

* Techniques for finding system operating points and linearizing the response of
Simscape models, see “Trimming and Linearization” (Simscape).

» Troubleshooting Simscape simulations, see “Troubleshooting” (Simscape).



Examine the Simulation Data-Logging Configuration of a Model

Examine the Simulation Data-Logging Configuration of a

Model

Many analyses that you can perform using Simscape Power Systems require a simulation
log variable in your MATLAB workspace. The model in this example is configured to log
Simscape data for the whole model for the entire simulation time. To examine the data-
logging configuration of a model:

1

Open the model. At the MATLAB command prompt, enter

model = 'pe rectifier power dissipated';
open(model)

Open the model configuration parameters and then, in the left pane, select
Simscape. Relevant parameters are:

* Log simulation data — Data logging is enabled for the whole model because this
parameter is set to A1l so you can calculate the power dissipated by any of the
semiconductors in the model.

* Workspace variable name — This parameter, which is also referred to as the
name of the simulation log variable, is specified as
simlog pe rectifier power dissipated.

* Limit data points — You can calculate the power dissipated for the entire
simulation time because the option is not selected.

Alternatively, you can determine the Simscape data-logging configuration without opening
the model configuration parameters, by using the get param function. For example, for
the pe _rectifier power dissipated model, to determine:

If all, some, or no data is logged, at the MATLAB command prompt, enter
get param(model, 'SimscapelLogType')
ans =

"all'

The name of the Simscape logging variable

get param(model, 'SimscapeLogName"')
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ans =

'simlog pe rectifier power dissipated'
» If the option to limit data-points is on or off

get param(model, 'SimscapelLogLimitData')
ans =

"off!

See Also

Functions
get param

Related Examples
. “Data Logging” (Simscape)
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Simulate Thermal Losses in Semiconductors

In this section...

“Prerequisite” on page 7-5

“Thermal Variants” on page 7-5

“Thermal Blocks” on page 7-5

“Thermal Ports” on page 7-6

“Thermal-Modeling Parameters” on page 7-7
“Limitations” on page 7-7

“Model Thermal Losses for a Rectifier” on page 7-8

Prerequisite

This example requires a simulation log variable in your MATLAB workspace. The model in
this example is configured to log Simscape data for the whole model for the entire
simulation time.

To learn how to determine if a model is configured to log simulation data, see “Examine
the Simulation Data-Logging Configuration of a Model” on page 7-3.

Thermal Variants

Thermal modeling provides data that helps you to estimate cooling requirements for your
system. The nonideal blocks in the Simscape Power Systems Simscape Components
Semiconductors library have thermal variants that allow you to determine device
temperatures by simulating heat generation. For example, the IGBT block, which models
a three-terminal semiconductor device, has thermal variants that can simulate the heat
generated by switching events and conduction losses. Selecting a thermal variant for a
block adds a thermal port to the block and enables the associated thermal-modeling
parameters.

Thermal Blocks

In the Semiconductors library, the Fundamental Components sublibrary includes a
Thermal sublibrary of blocks that allow you to model heat transfer using thermal variants:
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* Cauer Thermal Model Element — A thermal component that, in a series connection,
models heat transfer as a function of the thermal characteristics of the individual
physical components and materials, for example, a chip, solder, and base that make up
a semiconductor.

* Foster Thermal Model — A thermal component that models heat transfer as a function
of the thermal characteristics of a semiconductor.

* Thermal Resistor — A thermal interface resistance component that models conductive
heat transfer through a layer of material. Use the Thermal Resistor block to
parameterize heat transfer using the thermal resistance value of the material.

Thermal Ports

Thermal ports are physical conserving ports in the Simscape thermal domain. Thermal
ports on Simscape Power Systems Simscape Components semiconductors are associated
with temperature and heat flow. The figure shows a thermal port on a thermal variant of
the IGBT block.

Thermal [ o
F‘u:rrt...\* \@

—40 B

IGBT

Thermal ports are associated with temperature and heat flow which are the Across and
Through variables of the Simscape thermal domain. To measure thermal variables, you
can use one or both of these methods:

1 Log simulation data using a Simscape logging node. View the data using the
sscexplore function.

2 Add a sensor from the Simscape > Foundation Library > Thermal > Thermal
Sensors library to your model. To measure temperature, use a parallel-connected
Ideal Temperature Sensor block. To measure heat flow, use a series-connected Ideal
Heat Flow Sensor block.

There are several advantages to using data logging for desktop simulation. Data logging
is less computationally costly than using a sensor block and it allows you to:
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* View post-simulation results easily using the Simscape Results Explorer.
* Output data easily to the MATLAB Workspace for post-processing analysis.

However, if you use only data logging to measure a variable, you cannot output a
feedback signal for that variable to a control system during simulation as you can when
you use only a sensor to measure the variable. Also, because data logging is not
supported for code generation, you cannot use Simscape data logging when you perform
real-time simulation on target hardware.

Thermal-Modeling Parameters

Thermal-modeling parameters are device-specific characteristics that determine how
much heat a block generates during simulation. When you select a thermal variant for a
Diode or Commutation Diode block, no additional parameters are enabled because the
default variant includes all parameters necessary to model conduction loss. When you
select a thermal variant for a three-terminal semiconductor block, additional thermal-
modeling parameters are enabled because the default variant does not include
parameters necessary to model switching losses.

Three-terminal semiconductors allow you to parameterize thermal losses based on
Voltage and current or on Voltage, current, and temperature. If you parameterize
thermal characteristics based only on voltage and current, use scalar values to specify
these parameters:

* Output current
* Switch-on loss

* Switch-off loss

* On-state voltage

If you parameterize thermal losses based on Voltage, current, and temperature, use
vectors to specify the temperature, output current, switching losses, and on-state voltage.

Limitations
Even though simulating thermal losses generates information about the thermal state of a

block, thermal dynamics do not affect the electrical behavior of Simscape Power Systems
blocks during simulation.
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Model Thermal Losses for a Rectifier
Model Heat Transfer for a Single Rectifier Diode

To model and measure heat transfer as a function of the thermal characteristics of a
semiconductor, connect a Foster model-based thermal network and a temperature sensor
to the thermal port on Diodel.

1 Open the model, at the MATLAB command prompt, enter
pe rectifier diodes

The model contains a three-phase rectifier that includes six Diode blocks.

2 Select a thermal variant for the Diodel block, right-click the block and, from the
context menu, select Simscape > Block choices. Select Show thermal port.

3 Add a Simscape Power Systems Simscape Components block that represents heat
flow between the diode and the environment. In the model window, the text on the
right, contains links that open the Simulink Library browser. Click Semiconductors
> Fundamental Components > Thermal and add a Foster Thermal Model block to
the model.

4  Modify these Foster Thermal Model block parameters:

a Thermal resistance data — specify [ 0.00311 0.008493 0.00252
0.00288 1 K/W.

b Thermal time constant data — specify [ 0.0068 0.0642 0.3209
2.0212 ]s.

5 Represent the ambient temperature as constant using an ideal temperature source.

a  From the Simulink Library browser, open the Simscape > Foundation Library
> Thermal > Thermal Sources library and add an Ideal Temperature Source
block.

b  From the Simscape > Foundation Library > Thermal > Thermal Elements
library, add a Thermal Reference block.

¢ From the Simscape > Foundation Library > Physical Signals > Sources
library, add a PS Constant block. For the Constant parameter, specify a value of
300.

6 Measure and display the temperature of Diodel:

a From the Simulink Library browser, open the Simscape > Foundation Library
> Thermal > Thermal Sensors library, add an Ideal Temperature Sensor block.
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b  Make a copy of one of the PS-Simulink Converter blocks in the model window.
For the Output signal unit parameter, select K.

¢ From the Simulink Library browser, open the Simulink > Sinks library and add
a Scope block.

7 Arrange and connect the blocks as shown in the figure.
) _"E S
Tl L L

Salvar
Ganfguratin

veltage Source Currern Senaar + +

= Eiecmes Aeersnce

Three-Phase Rectifier

1. View Rranes in Simalink Lizeary Browser
Simacape
Simscape » Foundatien Library > Thermal
= a1 Library = Phys:

4. Leam mare about the Foster Themal hMadel biock.

75 oot

8 Label the signal from the PS-Simulink Converter block to the Scope block, double-
click the line between the blocks and at the prompt, enter Temp (K).

9 Simulate the model.
10 To see the temperature data, open the Scope block.



7 Simulation and Analysis of Power Engineering Systems

Temp (K)
.. I 1 _ T _ T _ 7T 7T  __—"“"T T "™

The temperature of Diodel fluctuates over a temperature range of 0.3 K as it
increases from the initial value of 300 K to a settling point of 300.6-300.9 K toward
the end of the simulation.

Model Heat Transfer for All Rectifier Diodes

To see the total heat generated by all the semiconductors in the rectifier, use data logging
and the Simscape Results Explorer.

1 To enable the thermal ports on all the rectifier diodes, select thermal variants for the
Diode2, Diode3, Diode4, Diode5, and Diode6 blocks.

2 To measure heat transfer for each diode, create a Foster thermal model subsystem:

a Make a copy of this group of blocks:
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+ Foster Thermal Model
o Ideal Temperature Source
* PS Constant
* Thermal Reference
b  Arrange and connect the copied blocks as shown in the figure.
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e

Create a subsystem from the copied blocks and rename the subsystem as
Foster_D2. For information see, “Create a Subsystem” (Simulink).

Open the Foster D2 subsystem. For the Conn1 block, for the Port location on
the parent subsystem parameter, select Right.

AN Diode2

Cornl

Foster_D2

TN

L

Phiase Splithar

Make four copies of the Foster_D2 subsystem. Attach one subsystem to each of
the remaining Diode blocks and rename the subsystems as Foster_D3 through
Foster_D6 to match the Diode3 through Diode6 block names.

Simulate the model.
View the results using the Simscape Results Explorer:

In the model window, in the text under Three-Phase Rectifier, click Explore
simulation results.

To display the temperature data for Diodel, in the Simscape Results Explorer
window, expand the Diodel > H node and click T.

To display the DC voltage in a separate plot, expand the Voltage_Sensor node
and CTRL+click V.

To display the temperature data for all the diodes, expand the Diode2 > H node
and CTRL+click T. Repeat the process for Diode3 through Diode6.

To overlay the temperature data in single plot, in the Simscape Results Explorer

window, above the tree-node window, click the options button. In the Options
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dialog box, for Plot signals, select Overlay. To accept the change, click OK.
Click and drag the legend down to see the temperature data clearly.
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See Also

The temperature profile for each diode lags, in succession, behind the temperature
profile of Diodel. For each diode, the temperature also rises and settles along the
same values as the temperature profile for Diodel. The data indicate that, because
of the lagging behavior of the individual diode temperatures, the temperature of the
rectifier rises and settles along the same temperature profile as the diodes, but with
less fluctuation.

References

[1] Schiitze, T. AN2008-03: Thermal equivalent circuit models. Application Note. V1.0.
Germany: Infineon Technologies AG, 2008.

See Also

Cauer Thermal Model Element | Commutation Diode | Diode | Foster Thermal Model |
GTO | IGBT | MOSFET | Thermal Resistor | Thyristor

Related Examples
. “Quantifying IGBT Thermal Losses”
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Perform a Power-Loss Analysis

7-16

In this section...

“Prerequisite” on page 7-16
“Calculate Average Power Losses for the Simulation” on page 7-16

“Analyze Power Dissipation Differences Using Instantaneous Power Dissipation” on page
7-18

“Mitigate Transient Effects in Simulation Data” on page 7-22

This example shows how to analyze power loss and how to mitigate transient power
dissipation behavior. Analyzing power loss, with and without transients, is useful for
determining if components are operating within safety and efficiency guidelines.

Prerequisite

This example requires a simulation log variable in your MATLAB workspace. The model in
this example is configured to log Simscape data for the whole model for the entire
simulation time.

To learn how to determine if a model is configured to log simulation data, see “Examine
the Simulation Data-Logging Configuration of a Model” on page 7-3.

Calculate Average Power Losses for the Simulation

1 Open the model. At the MATLAB command prompt, enter

model = 'pe rectifier power dissipated';
open(model)



Perform a Power-Loss Analysis

Solver

Configuration

Voltage Source
Impedance

Voltage Source

— Electrical Referance

~ V(PS5 5 )
'.—’- S e

o]
— Phase Currents

Line Violtage Sansar

-3 Cc

Current Sensor

Rectifier

Power-Loss Analysis of a Three-Phase Rectifier

2  Simulate the model.

sim(model)

The simulation log variable, which is named
simlog pe rectifier power dissipated, appears in the workspace.

3 Calculate the average losses for the entire simulation for each of the diodes in the

model.

[l > |

Dissipated DS

WdcDE
Vde_DE

oltage Sensor
—-
PS-Simulink Pd_D& r—
Converter2 Dissipated D6 Currents,
Voltages, and

Pawer Dissipation

rectifierLosses = pe_getPowerLossSummary(simlog pe rectifier power_dissipated.Rectifier)

rectifierLosses =

6x2 table

LoggingNode

'pe rectifier power dissipated.Rectifier.D6'
'pe rectifier power dissipated.Rectifier.D3'
'pe rectifier power dissipated.Rectifier.D4'
'pe rectifier power dissipated.Rectifier.D5'
'pe rectifier power dissipated.Rectifier.D1l'
'pe rectifier power dissipated.Rectifier.D2'

Power

52.222
52.222
52.194
52.194
52.194
52.194

On average, diodes D3 and D6 dissipate more power than the other diodes in the

rectifier.

7-17



7 simulation and Analysis of Power Engineering Systems

7-18

Analyze Power Dissipation Differences Using Instantaneous
Power Dissipation

The Diode blocks each have a power dissipated variable, which measures instantaneous
power dissipation. To investigate the differences in the average power dissipated by the
diodes, view the simulation data using the Simscape Results Explorer.

1 Open the simulation data using the Results Explorer.

sscexplore(simlog pe rectifier power dissipated)
2 View the instantaneous power dissipated by the diodes.

a Expand the Rectifier node
Expand the D1 through D6 nodes

Click the power dissipated nodes for diode D1, and then Ctrl+click the
power dissipated nodes for the other five diodes.



Perform a Power-Loss Analysis
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At the beginning of the simulation, there is a difference in the power dissipation for

each diode.

3 Take a closer look at the differences. Overlay the plots and zoom to the beginning of

the simulation.

b Enable the Limit time axis option.

In the Results Explorer window, click the plot options button.
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¢ For Stop time, specify 0.02.
d Set Plot signals to Overlay.
e Click OK.

|4\ Simscape Results Explorer: pe_rectifier_power_dissipated - O
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The variation in power dissipation is due to transient behavior at the beginning of the
simulation. The model reaches steady state at simulation time, t = 0.001 seconds.

4 Determine the average power dissipation for only the diodes during the interval that
contains transient behavior.
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rectifierLosses = pe_getPowerLossSummary(simlog pe rectifier power dissipated.Rectifier,0,1le-3)

rectifierLosses =
6x2 table
LoggingNode Power
'Rectifier.D3' 174.88
'Rectifier.D6' 174.88
'Rectifier.D4' 0.27539
'Rectifier.D5' 0.27539
'Rectifier.D1' 0.12482
'Rectifier.D2' 0.032017

The average power dissipated by diodes D3 and D6 exceeds the average for the other
diodes.

Output a table of the maximum power dissipation for each diode, for the entire
simulation time.

pd_D1 max = max(simlog pe rectifier_power_dissipated.Rectifier.D1l.power_dissipated.series.values);
pd_D2 max = max(simlog pe rectifier_ power dissipated.Rectifier.D2.power_dissipated.series.values);
pd_D3 max = max(simlog pe rectifier_power dissipated.Rectifier.D3.power_dissipated.series.values);
pd_D4 max = max(simlog pe rectifier_power dissipated.Rectifier.D4.power dissipated.series.values);
pd_D5 max = max(simlog pe rectifier_power dissipated.Rectifier.D5.power_dissipated.series.values);
pd_D6 _max = max(simlog pe rectifier_power dissipated.Rectifier.D6.power_dissipated.series.values);
diodes = {'D1';'D2';'D3"';'D4"';'D5';'D6"'};

PowerMax = [pd_D1 max;pd_D2 max;pd D3 max;pd_D4 max;pd D5 max;pd D6 max];

T = table(PowerMax, 'RowNames', diodes)

T:
6x1 table
PowerMax
D1 166.45
D2 166.45
D3 339.54
D4 166.45
D5 166.45
D6 339.54
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The maximum instantaneous power dissipation for diodes D3 and D6 is almost double
the maximum instantaneous power dissipation for the other diodes.

Mitigate Transient Effects in Simulation Data

To mitigate the transient power dissipation at the beginning of the simulation, use the
final simulation state to initialize a new simulation at steady-state conditions.

1 Configure the model to save the final state.

Open the model configuration parameters.
In the Solver pane, change the Stop time from 0.5 to le-3.
¢ Inthe Data Import/Export pane, select these options:

* Final States
* Save complete SimState in final state
d Click Apply.
2 Run the simulation.

The final state is saved as the variable xFinal in the MATLAB workspace.

3 Configure the model to initialize using xFinal, in the model configuration parameters.

a In the Data Import/Export pane:

* Select the Initial state option.
* Change the Initial state parameter value from xInitial to xFinal.
* C(Clear the Final states option.
b In the Solver pane, change the Stop time to 0.5.
¢ Click OK.
4 Run the simulation.
View the data from the new simulation.

Click the Reload logged data S button in the Simscape Results Explorer.

b  Click OK to confirm that simlog pe rectifier power dissipated isthe
variable name that contains the logged data.



Perform a Power-Loss Analysis

¢ To see the data more clearly, click and drag the legend away from the peak

amplitudes.
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The plot shows that the simulation no longer contains the transient.

6 Output a table of the maximum power dissipation for each diode, for the modified

simulation.

pd_D1_max
pd_D2_max
pd_D3_max

max(simlog _pe rectifier power dissipated.Rectifier.Dl.power dissipated.series.values);
max(simlog _pe rectifier power dissipated.Rectifier.D2.power dissipated.series.values);
max(simlog _pe rectifier power dissipated.Rectifier.D3.power dissipated.series.values);
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pd D4 max = max(simlog pe rectifier power dissipated.Rectifier.D4.power dissipated.series.values);
pd D5 max = max(simlog pe rectifier power dissipated.Rectifier.D5.power dissipated.series.values);
pd D6 max = max(simlog pe rectifier power dissipated.Rectifier.D6.power dissipated.series.values);
diodes = {'D1';'D2';'D3"';'D4"';'D5"';'D6'};

PowerMax = [pd D1 max;pd D2 max;pd D3 max;pd D4 max;pd D5 max;pd D6 max];

T = table(PowerMax, 'RowNames', diodes)

T:
6x1 table
PowerMax
D1 166.45
D2 166.45
D3 166.45
D4 166.45
D5 166.45
D6 166.45

The maximum instantaneous power dissipation for diodes D3 and D6 is the same as
the maximum instantaneous power dissipation for the other diodes.

See Also

Functions
pe getEfficiency | pe getPowerLossSummary | pe getPowerLossTimeSeries

Related Examples
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“Power-Loss Analysis of a Three-Phase Rectifier”

“Examine the Simulation Data-Logging Configuration of a Model” on page 7-3
“Data Logging” (Simscape)

“About the Simscape Results Explorer” (Simscape)



Choose a Simscape Power Systems Function for an Offline Harmonic Analysis

Choose a Simscape Power Systems Function for an
Offline Harmonic Analysis

In this section...

“Harmonic Distortion” on page 7-25

“Harmonic Analysis Functions” on page 7-25

“Evaluate Relative Overall Harmonic Distortion” on page 7-26
“Compare Harmonic Distortion to Standard Limits” on page 7-27
“Minimize Harmonic Distortion with Passive Filters” on page 7-27
“Verify the Results of an Online Harmonic Analysis” on page 7-28

Harmonic Distortion

Nonlinear loads create power distortion in the form of harmonics, that is, voltages and
currents that are multiples of the fundamental frequency. Harmonic waveforms can result
in energy losses though heat dissipation and in reduced power quality. They can also
cause equipment to malfunction or to become damaged. Standards development
organizations such as the Institute of Electrical and Electronics Engineers (IEEE) and the
International Electrotechnical Commission (IEC) define the recommended limits for
harmonic content in electric power systems.

Harmonic Analysis Functions

You can use the simulation and analysis functions in Simscape Power Systems Simscape
Components to perform an offline, that is post-simulation, analysis to examine harmonic
distortion in your model. The pe_plotHarmonics function generates a bar chart. The
pe getHarmonics and pe calculateThdPercent functions provide harmonic data in
numerical form.

To decide which functions and workflows to use for your harmonic analysis, consider your
goals. The table cross-references the harmonic functions with common harmonic analysis
according to the data the function outputs and the task requires.
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Goal

pe_plotHarmonics

pe_getHarmonics

pe_calculateThdPercen
t

Evaluate the
relative overall
harmonic
distortion

Bar chart of the
percentage of
fundamental
magnitude

¢ Fundamental
peak value

¢ Total harmonic
distortion (THD)
percentage

Compare the
harmonic
distortion to
standard limits

¢ Fundamental
frequency

* Harmonic orders

* Harmonic
magnitudes

Total harmonic distortion
(THD) percentage

Determine the
parameters for
filtering
harmonic
distortion

* Fundamental
frequency

e Harmonic orders

e Harmonic
magnitudes

Evaluate Relative Overall Harmonic Distortion

Use this workflow for a high-level understanding of the waveform distortion in your power

system.

Enable Simscape data logging.

Save the logged voltage or current data to a variable.

Use the pe plotHarmonics function to generate a bar chart of harmonic
percentages with the peak fundamental magnitude and the total harmonic distortion
(THD) percentage displayed in the plot title.




Choose a Simscape Power Systems Function for an Offline Harmonic Analysis

Compare Harmonic Distortion to Standard Limits

Use this workflow to obtain values for evaluating the IEEE or IEC suitability of your
power system.

1
2

N o »u b

Enable Simscape data logging.
Save the logged voltage or current data to a variable.

Use the pe_getHarmonics function to obtain the harmonic orders, the magnitude
for each order, and the fundamental frequency.

Save the fundamental peak to a new variable.
Calculate the RMS voltage or current for each order.
Calculate the harmonic distortion percentage for individual harmonics.

Use the pe calculateThdPercent function to obtain the total harmonic distortion
(THD).

Compare the percentage data for each order and the THD percentage to the standard
limits.

Minimize Harmonic Distortion with Passive Filters

Use this workflow to determine the parameters for filtering the distorted waveforms with
passive filters. Use individual, series-tuned filters for specific harmonic orders. Use a
single high-pass filter to filter higher orders.

Enable Simscape data logging.
Save the logged voltage or current data in a variable.

Use the pe_getHarmonics function to obtain the harmonic orders, the magnitude
for each order, and the fundamental frequency.

Identify the harmonic orders that you want to filter.

For each filter:

a  Specify the filter size, in terms of reactive power compensation, and specify the
filter quality.

b Calculate the capacitor reactance at the tuned harmonic order.
Calculate the filter capacitance.

d Calculate the inductor reactance at the tuned harmonic order.
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e Calculate the filter inductance.
f  Calculate the filter resistance.

Verify the Results of an Online Harmonic Analysis

You can examine harmonic distortion in your model online, that is during simulation,
using the Simscape Spectrum Analyzer block. To verify the results from the Spectrum
Analyzer block:

1 To determine the THD in your model, perform an online analysis. For information, see
“Perform an Online Harmonic Analysis Using the Simscape Spectrum Analyzer Block”
on page 7-29.

2 Usethe pe getHarmonics and pe calculateThdPercent functions to determine
the THD in your model.

3 Compare the THD values for the online and offline analyses. If the results differ,
reconfigure the Spectrum Analyzer block.

See Also

Blocks
Spectrum Analyzer

Functions
pe calculateThdPercent | pe getHarmonics | pe plotHarmonics

Related Examples
. “Harmonic Analysis of a Three-Phase Rectifier”

. “Perform an Online Harmonic Analysis Using the Simscape Spectrum Analyzer
Block” on page 7-29

. “Data Logging” (Simscape)
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Perform an Online Harmonic Analysis Using the
Simscape Spectrum Analyzer Block

In this section...

“Harmonic Distortion” on page 7-29

“Prerequisite” on page 7-29

“Perform an Offline Harmonic Analysis” on page 7-30
“Perform an Online Harmonic Analysis” on page 7-33

Harmonic Distortion

Nonlinear loads create power distortion in the form of harmonics, that is, voltages and
currents that are multiples of the fundamental frequency. Harmonic waveforms can result
in energy losses through heat dissipation and in reduced power quality. They can also
cause equipment to malfunction or to become damaged. Standards development
organizations such as the Institute of Electrical and Electronics Engineers (IEEE) and the
International Electrotechnical Commission (IEC) define the recommended limits for
harmonic content in electric power systems.

This example shows how to examine harmonic distortion in your model using offline, that
is after simulation, and online, that is during simulation, analyses. The offline analysis
uses the Simscape Power Systems harmonic analysis functions and helps you to
determine configuration settings for, and verify the results of, the online analysis. The
online analysis uses the Simscape Spectrum Analyzer block.

Prerequisite

This example requires a simulation log variable in your MATLAB workspace. The model in
this example is configured to log Simscape data for the whole model for the entire
simulation time.

To learn how to determine if a model is configured to log simulation data, see “Examine
the Simulation Data-Logging Configuration of a Model” on page 7-3.
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Perform an Offline Harmonic Analysis

1 Open the model. At the MATLAB command prompt, enter:

model = 'pe composite rectifier';

open_system(model)

Fix) =0 s ~ ~1 -2
Salver
Configuration
Voltage Source Voltage Source
Impedance

"— Elactrical Referance

~2

Current Sansor

P5-Simulink

tPs 5 >0 N
=

u]

Selector Scope
Converter
i
+
. DC
Sl
Rectifier

AC

Sy

lectrical Reference

L

The example model contains a three-phase rectifier. The model also contains a
Selector block that outputs only the a-phase from three-phase current signal that it

receives from the PS-Simulink Converter block.

2 Simulate the model.

sim(model)

3  View the time-domain results. Open the Scope block.
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The time domain analysis shows that the rectifier is converting the voltage, but it
does not include any information about the frequencies in the signal.

4 Determine configuration settings and calculate the expected results for an online
harmonic analysis. Perform an offline harmonic analysis.

a The Simscape Power Systems harmonic analysis functions require that you use a
fixed-step solver. Determine the solver type and sample time for the model. To

turn on sample-time highlighting, in the Simulink editor menu bar, select Display
> Sample Time > All.

pe_composite_rectifier

Sample Times for 'pe_composite_rectifier’

Color Annotation Description Value
] D1 Discrete 1 0.0001

Print

The model is running at a discrete rate, therefore it is using a fixed-step solver,
with a sample time of 1e-4 s.
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Use the pe_getHarmonics function to calculate the harmonic order, the
harmonic magnitude, and the fundamental frequency based on the voltage
source currents.

[harmonicOrder,harmonicMagnitude, fundamentalFrequency] = ...
pe_getHarmonics(simlog composite rectifier.Voltage Source.I);

Performing an online harmonic analysis using the Spectrum Analyzer block
requires that you specify a value for maximum harmonic order and the resolution
bandwidth (RBW). The RBW depends on the fundamental frequency.

Extract and display the maximum harmonic order and the fundamental
frequency:

', num2str(max(harmonicOrder))])
", num2str(fundamentalFrequency)])

disp(['Maximum Harmonic Order
disp(['Fundamental Frequency

30
60

Determine the peak value of the fundamental frequency. This value is useful for
filtering out negligible harmonics and for verifying the results of the offline
analyses.

Maximum Harmonic Order
Fundamental Frequency

fundamentalPeak = harmonicMagnitude(harmonicOrder==1);
disp(['Peak value of fundamental = ', num2str(fundamentalPeak),' A']l);

Peak value of fundamental = 1945.806 A

Filter out small harmonics by identifying and keeping harmonics that are greater
than one thousandth of the fundamental peak frequency.

threshold = fundamentalPeak ./ le3;

aboveThresold = harmonicMagnitude > threshold;
harmonicOrder = harmonicOrder(aboveThresold)"';
harmonicMagnitude = harmonicMagnitude(aboveThresold)"';

Display the harmonic data in a MATLAB table.

harmonicRms harmonicMagnitude./sqrt(2);
harmonicPct 100.*harmonicMagnitude./harmonicMagnitude(harmonicOrder == 1);
harmonicTable = table(harmonicOrder,...
harmonicMagnitude, ...
harmonicRms, ...
harmonicPct, ...
'VariableNames',{'Order"', '"Magnitude', 'RMS"', 'Percentage'});
display(harmonicTable);

harmonicTable =



Perform an Online Harmonic Analysis Using the Simscape Spectrum Analyzer Block

10x4 table
Order Magnitude RMS Percentage
1 1945.8 1375.9 100
5 218.86 154.75 11.248
7 105.83 74.835 5.439
11 85.135 60.2 4.3753
13 57.599 40.729 2.9602
17 50.417 35.65 2.5911
19 37.612 26.596 1.933
23 33.859 23.942 1.7401
25 26.507 18.743 1.3622
29 23.979 16.955 1.2323

Calculate the total harmonic distortion (THD) percentage using the
pe calculate ThdPercent function.

thdPercent = pe_calculateThdPercent(harmonicOrder, harmonicMagnitude);
disp(['Total Harmonic Distortion Percentage = ' num2str(thdPercent),' %'1);

Total Harmonic Distortion percentage = 14.1721 %

Perform an Online Harmonic Analysis

1

In the Simulink editor that contains the pe_composite rectifier model, replace
the Scope block with a Spectrum Analyzer block from the Simscape Utilities Library:

a
b

C

Delete the Scope block.
Left-click within the block diagram.

After the search icon appears, type spec, and then from the list, select the
Spectrum Analyzer from the Utilities library.

Connect the Spectrum Analyzer block to the output signal from the Selector
block.
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fix) =0 - ~1 ~2 ~1

ahw

Voltage Source
Impedance i

2 Configure the Spectrum Analyzer block using the Spectrum Settings panel.

Sk

a  Open the Spectrum Analyzer.
Open the Spectrum Settings panel. On the Spectrum Analyzer toolbar, click the

Spectrum Settings =) button.
¢ Configure the parameters on the Main Options pane.
i Configure the block to display the root mean square (RMS) of the frequency.
From the Type dropdown menu, select RMS.

ii  Determine the value to specify for the resolution bandwidth (RBW) using this
equation:

NENBW *f
N

RBW =

2

where,

* NENBW is the normalized effective noise bandwidth, a factor of the
windowing method used. The Hanning (Hann) window has an NENBW
value of approximately 1.5.
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* fis the fundamental frequency.
* N s the number of periods.
* RBW is the resolution bandwidth in Hz.

For a fundamental frequency of 60 Hz over 10 periods, using a Hann
window,

For RBW (Hz), specify 9.
d Expand the Windows Options pane and specify an Overlap (%) of 90.

e Specify the maximum number of peaks for the analyzer to display. In the menu
bar, select Tools > Measurements > Peak Finder. Alternatively, in the

Spectrum Analyzer toolbar, select the Peak Finder Ll button. In the Peakfinder
pane, in the Settings section, for Max Num of Peaks, enter 30. This value is
based on the maximum harmonic order as indicated by the offline analysis.

f  Set the number of harmonics to use for measuring harmonic distortion. Specify a
number that captures the largest harmonic order that the offline analysis
captures. In the menu bar, select Tools > Measurements > Distortion
Measurements. Alternatively, in the Scope toolbar, click the Distortion

Measurements button. Scroll as required to see the Distortion
Measurements pane.

In the Distortion Measurements pane, for Num Harmonics, again enter 30.
3 Simulate the model.

sim(model)
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YY YV WY WY TV

Y YWY

* ¥ Spectrum Settings
¥ Main options
Type
Sample rate (Hz)
RBW (Hz)
Samples/update

» Window options

» Trace options

* ¥ Peak Finder

¥ Settings

Peak Threshold
Max Mum of Peaks
Min Peak Distance

Peak Excursion

Label Format

» Peaks

* ¥ Distortion Measurements

Distortion

¥ Harmonics

. Harmonics: [

M Label harmonics
Freq. (kHz) Power (Wrms)
0.059988 1375.89
Freq. (kHz) Power (dBc)
0113977 -1375.89 [« |
0.179964 -1375.86
0.233953 -1375.89
0.29994 -1221.15
0.353929 -1375.88
0.419316 -1301.06
0.485903 -1375.88
0.539892 -1375.86
0.593881 -1375.88 [~ |
THD -16.97 dBc (14.17%)
SNR. 33.89 dBc
SINAD 16.89 dBc
SFDR: 18.98 dBc




See Also

The THD percentage is 14.17% and the fundamental peak power is 1375.89 Vrms at
0.06 kHz (60 Hz). These results agree with the results from the offline harmonic
analysis.

See Also

Blocks
PS-Simulink Converter | Selector | Spectrum Analyzer

Functions
pe calculateThdPercent | pe getHarmonics | pe plotHarmonics

Related Examples

. “Harmonic Analysis of a Three-Phase Rectifier”
. “Choose a Simscape Power Systems Function for an Offline Harmonic Analysis” on
page 7-25

. “Data Logging” (Simscape)
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Optimize Block Settings for Simulations that Use the
Partitioning Solver

7-38

In this section...

“Update Solver and Zero-Sequence Settings Using the pe solverUpdate Function” on
page 7-39

“Limitations of the pe updateSolver Function” on page 7-48

The Partitioning solver is a Simscape fixed-step local solver that improves performance
for certain models. However, not all networks can simulate with the Partitioning solver.
Some models that use the Partitioning solver can produce errors and fail to initialize due
to numerical difficulties. To resolve numerical difficulties preventing initialization with
asynchronous, synchronous, and permanent magnet rotor machine blocks, you can
exclude zero-sequence terms. Excluding parasitic conductance resolves numerical
difficulties with the Floating Neutral and Neutral Connection block, which include such
conductance by default.

To determine the best solver choice for your model, use the pe_updateSolver helper
function, which is useful for iterating with various solvers. The function updates certain
parameter values for every instance of these blocks in your model:

* Solver Configuration blocks

* Machine blocks that have a Zero sequence parameter

* Connection blocks that have a Parasitic conductance to ground parameter

The function syntax is pe_updateSolver(solver,system). Specify both input

arguments using character vectors. The table shows how the function updates the values,
depending on the solver that you specify.



Optimize Block Settings for Simulations that Use the Partitioning Solver

Input Solver Solver Asynchronous, Floating
Argument Configuration |Configuration |Synchronous, [Neutral Block
Block (Solver |Block (Use and Permanent|and Neutral
type) local solver Magnet Rotor |Connection
and Use fixed- |Machine Blocks|Block
cost runtime |(Zero (Parasitic
consistency sequence) conductance to
iterations) ground)
'Partitioning’ Partitioning Selected Exclude 0
'‘Backward Backward Euler |Selected Include le-12
Euler' or
'‘BackwardEuler’
‘Trapezoidal' Trapezoidal Selected Include le-12
'Global' or No change Cleared Include le-12
'Nonlocal'

Update Solver and Zero-Sequence Settings Using the
pe_solverUpdate Function

This example shows how to use the pe_solverUpdate function to configure the Solver
Configuration and a Permanent Magnet Synchronous Motor blocks in a model for

simulation with the Partitioning solver and the Backward Euler solver. It also shows how
to compare the simulation duration times and the results.

1 Open the model. At the MATLAB command prompt, enter this code.

See Code

model = 'pe pmsm drive';
open_system(model)
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Synchronous Maotor

P

Three-Phase PMSM Drive

This example shows a Permanent Magnet Synchronous Machine (PMSM) and inverter sized for use in a typical hybrid wehicle.
Hara the inverter is connected directly to the vehicle battery, but often there is also a DC-DC converter stage in between. The
madel can be used to design the PMSM controller, selecting architecture and gains fo achieve desired performance. To check
the timing of IGBT tum-on and turn-off, the IGBT devices can be directly replaced by more detailed device models from
Simzcape{TM)} Electronics(Th). For complete wehicle modeling, the Simscape Electronics Servomotor block can be used to
abstract the PMSM, inverter and controller with an energy-based model. The Gmin resistor provides a very small conductance
to ground that improves the numerical properties of the model when using a variable-step solver.

Two blocks that the pe_solverUpdate function can update are the Solver
Configuration block and Permanent Magnet Synchronous Motor (PMSM) block.

Save the parameter settings for the two blocks.

See Code

% Define the Solver Configuration block and the path
% to it as variables

solvConfig = 'Solver Configuration';

solvConfigPath = [model,'/',solvConfig];

% Define the machine block and the path
to it as variables

o°
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machine

= 'Permanent Magnet Synchronous Motor';
machinePath = [model, '/',machine];

% Create a cell array that contains configuration data
configBaseline = {'Block', 'Parameter’', 'Value';

'Solver Configuration', 'Use local solver',...

get param(solvConfigPath, 'UseLocalSolver"');
'Solver Configuration', 'Solver type',...

get param(solvConfigPath, 'LocalSolverChoice');
'Solver Configuration', 'Sample time',...

get param(solvConfigPath, 'LocalSolverSampleTime');

'Solver Configuration',...

'Use fixed-cost runtime consistency iterations',...
get param(solvConfigPath, 'DoFixedCost');

'Machine', 'Zero sequence',...

get param(machinePath, 'zero_sequence')};

The settings are saved to configBaseline array in the MATLAB workspace.

configBaseline

[£3] 6x3 cell

1 2 3
1 Block Parameter ‘alue
2 Solver Configuration Use local salver off

3 Solver Configuration
4 Solver Configuration
5 Solver Configuration
6 Machine

Solver type

Sample time

Use fixed-cost runtime consistency iterations
Fero sequence

ME_BACKWARD_EULER_ADVANCER
Ts

off
pe.enum.park.zeraseguence.include

The settings of interest for the Solver Configuration block are:

* Use local solver — The option to use a local Simscape solver is cleared.

* Solver type — Backward Euler, a Simscape local fixed- cost solver, is specified.
However, if you open the block dialog box, you can see that it is not enabled

because the option to use a local solver is cleared.

* Use fixed-cost runtime consistency iterations — The option to use fixed-cost is
cleared. This option is also disabled when the option to use a local solver is
cleared.
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For the machine, the Zero sequence parameter is set to Include. Zero-sequence
equations can cause numerical difficulty when you simulate with the Partitioning
solver.

Mark the rotor torque signal, which connects the trqMotor From block to a Mux
block, for Simulink data logging and viewing with the Simulation Data Inspector
(SDI).

See Code

% Define the trgMotor From block and the path
% to it as variables

torqueSensor = 'From6';

torqueSensorPath = [model, '/',torqueSensor];

% Mark the output signal from the trgMotor From block

% for Simulink(R) data logging

phTorqueSensor = get param(torqueSensorPath, 'PortHandles');
set param(phTorqueSensor.Qutport(1), 'DataLogging', 'on')

The logging badge marks the signal in the model.
Determine the results and how long it takes to simulate with the baseline settings.

See Code

% Run a timed simulation using the Baseline solver configuration
tic;

sim(model);

tBaseline = toc;

Use pe_updateSolver function to change to the Backward Euler solver
configuration. Save the configuration settings, and compare the settings to the
baseline settings.

See Code

% Configure for Backward Euler solver simulation
pe_updateSolver('Backward Euler',model)

% Save the new parameter settings and compare them to the baseline
% configuration.
% Create a cell array that contains configuration data
configBackEuler = {'Block', 'Parameter', 'Value';

'Solver Configuration', 'Use local solver',...

get param(solvConfigPath, 'UseLocalSolver');

'Solver Configuration','Solver type',...
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get param(solvConfigPath, 'LocalSolverChoice');
'Solver Configuration', 'Sample time',...

get param(solvConfigPath, 'LocalSolverSampleTime');

'Solver Configuration',...

'Use fixed-cost runtime consistency iterations',...

get _param(solvConfigPath, 'DoFixedCost');
'Machine', 'Zero sequence',...
get _param(machinePath, 'zero_sequence')};

% Compare the Partitioning solver block settings to the Baseline settings
configDiff = setdiff(configBackEuler,configBaseline)

configDiff =

1x1 cell array

{'on'}
configBackEuler
[£3] 6x3 cell
1 2 =
1 Elnck Parameter Yalue
2 Salver Configuration Use local solver an

3 Solver Configuration
4 Solver Configuration
5 Solver Configuration
6 Machine

Solver type

Sample time

Use fixed-cost runtime consistency iterations
Zero sequence

NE_BACKWARD_EULER_ADVANCER
Ts

on
pe.enum.park.zerosequence.include

The option to use the local solver, which is set to Backward Euler by default, and the
option to use fixed-cost runtime consistency iterations are now both selected.

6 Run a timed simulation using the Backward Euler solver.

See Code

tic;

sim(model)
tBackEuler

= toc;

7 Ifyou change the local solver to the Partitioning solver and simulate the model now,
an error occurs because of the zero-sequence terms. Use the pe _updateSolver
function to configure the model for simulating with the Partitioning solver without
generating an error. Save the configuration settings, compare the settings to baseline
settings, and run a timed simulation.
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See Code

% Configure for Partioning solver simulation
pe updateSolver('Partitioning', model)

% Create a cell array that contains configuration data
configPartitioning = {'Block', 'Parameter', 'Value';
'Solver Configuration', 'Use local solver',...
get param(solvConfigPath, 'UseLocalSolver');
'Solver Configuration', 'Solver type',...
get param(solvConfigPath, 'LocalSolverChoice');
'Solver Configuration', 'Sample time',...
get param(solvConfigPath, 'LocalSolverSampleTime');
'Solver Configuration',...
'Use fixed-cost runtime consistency iterations',...
get param(solvConfigPath, 'DoFixedCost');
'Machine', 'Zero sequence',...
get param(machinePath, 'zero sequence')};

% Compare the Partitioning solver block settings to the Baseline settings
configDiff = setdiff(configPartitioning, configBaseline)

% Run a timed simulation using the Partitioning solver
tic;

sim(model)

tPartitioning = toc;

configDiff =
3x1 cell array

{'NE_PARTITIONING ADVANCER' }
{'on’ }
'}

{'pe.enum.park.zerosequence.exclude

Warning: Initial conditions for nondifferential variables not
supported. The following states may deviate from requested initial
conditions

['pe pmsm drive/Battery']

In elec.sources.battery base
['pe pmsm drive/Permanent Magnet Synchronous Motor']

7-44



Optimize Block Settings for Simulations that Use the Partitioning Solver

configPartitioning

[} 6x3 cell
1 2 3
1 Block Parameter Yalue
2 Solver Configuration Use local solver on
3 Solver Configuration Solver type NE_PARTITIOMING_ADVANCER
4 |Solver Configuration Sample time Ts
5 Solver Configuration Use fixed-cost runtime consistency iterations  on
G Machine Fero sequence pe.enum.parkzerosequence. exclude

The solver type is now set to the Partitioning solver and the machine is configured to

exclude zero-sequence terms.

The simulation runs without generating an error. It does generate a warning because
initial conditions for nondifferential variables are not supported for the Partitioning

solver.
8 Print tables that show:

* Simulation time for each solver

* Percent differences in speed for the local solvers versus the baseline global solver.

See Code

% Display the simulation times
compTimeDiffTable = table({'Baseline’;...
'Backward Euler';...
'Partitioning'}, ...
{tBaseline;tBackEuler;tPartitioning}, ...
'VariableNames', {'Solver','Sim Duration'});

display(compTimeDiffTable);

% Compute and display the percent difference for the simulation times

spdBackEulerVsBaseline
spdPartitionVsBaseline

100*(tBaseline - tBackEuler)/tBaseline;
100*(tBaseline - tPartitioning)/tBaseline;

compPctDiffTable = table({'Backward Euler versus Baseline';...

'Partitioning versus Baseline'}, ...
{spdBackEulerVsBaseline;. ..
spdPartitionVsBaseline}, ...
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'VariableNames', {'Comparison', 'Percent Difference'});

display(compPctDiffTable);

compTimeDiffTable =
3x2 table
Solver Sim Duration
'Baseline’ [36.4557]
'Backward Euler' [22.9982]
"Partitioning’ [ 9.7051]
compPctDiffTable =
2x2 table
Comparison Percent Difference
'Backward Euler versus Baseline' [36.9147]
'"Partitioning versus Baseline' [73.3783]

Simulation time on your machine may differ because simulation speed depends on
machine processing power and the computational cost of concurrent processes. The
local fixed-step Partitioning and Backward Euler solvers are faster than the baseline
solver, which is a global, variable-step solver. The Partitioning solver is faster than
the Backward Euler solver.

9 Compare the results using the Simulation Data Inspector.

See Code

Get Simulink Data Inspector run IDs for
the last three runs

runIDs = Simulink.sdi.getAllRunIDs;

runBackEuler = runIDs(end - 1);

runPartition = runIDs(end);

o o°

% Open the Simulink Data Inspector
Simulink.sdi.view

compBaselinePartition = Simulink.sdi.compareRuns(runBackEuler,...
runPartition);
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Baseline:

Compare to:

0.15

0.05
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Run 14: pe_pmsm_drive ¥ | Global Abs Tolerance: 0| Global Time Tolerance: 0
= Compare
Run 15: pe_pmsm_drive ¥ | Global Rel Tolerance: 0

¢c> BB |QQ ARIraR
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The first plot shows the overlay of the Backward Euler and Partitioning solver
simulation results. The second plot shows how they differ. The default tolerance for
differences is 0. To determine if the accuracy of the results meets your requirements,
you can adjust the relative, absolute, and time tolerances. For more information, see
“Compare Simulation Data” (Simulink).
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You can also use the pe_updateSolver function to reset the model for simulation with a
global solver.

See Code

% Configure for Global/Nonlocal solver simulation
pe _updateSolver('Global',model)

Limitations of the pe_updateSolver Function

Using the pe_updateSolver function does not guarantee that a simulation runs does
not generate an error or that a simulation produces accurate results. To ensure that
simulation accuracy meets your requirements, it is a recommended practice to compare
simulation results to baseline results whenever you change model or block settings.

See Also

Permanent Magnet Synchronous Motor | Solver Configuration

Related Examples

. “Increase Simulation Speed Using the Partitioning Solver” (Simscape)
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Prepare Simscape Power Systems Models for Real-Time
Simulation Using Simscape Checks

If you have a Simulink Real-Time license, you can optimize your model for real-time
execution using the Execute real-time application activity mode in the Simulink
Performance Advisor. This mode includes several checks specific to physical models. For
example, the Simulink Performance Advisor identifies Simscape Solver Configuration
blocks with settings that are suboptimal for real-time simulation. For optimal results,
Solver Configuration blocks should have the Use local solver and Use fixed-cost
runtime consistency iterations options selected.

The checks are organized into folders. You can use the checks in the Simscape checks
folder for all physical models. Subfolders contain checks that target blocks from Simscape
Power Systems and other add-on products such as Simscape Driveline™ and Simscape
Electronics.

Before you run the checks, use the processes described in “Real-Time Model Preparation
Workflow” (Simscape), “Real-Time Simulation Workflow” (Simscape), and “Hardware-In-
The-Loop Simulation Workflow” (Simscape).

To run the Simulink Real-Time Performance Advisor Checks:
1 In the Simulink Editor menu bar, select Analysis > Performance Tools >

Performance Advisor.

2 In the Performance Advisor window, under Activity, select Execute real-time
application.

3 In the left pane, expand the Real-Time folder, and then the Simscape checks folder.

Run the top-level Simscape checks and the Simscape Power Systems checks. If your
model contains blocks from other add-on products, also run the checks in the
subfolder corresponding to that product.

See Also

More About

. “Model Preparation Objectives” (Simscape)
. “Real-Time Model Preparation Workflow” (Simscape)
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. “Real-Time Simulation Workflow” (Simscape)
. “Use Performance Advisor to Improve Simulation Efficiency” (Simulink)
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Phasor-Mode Simulation in Simscape Components

You can run your model in phasor mode to speed up simulation. In Simscape, phasor
mode is known as frequency-time equation formulation. In general, this formulation leads
to accurate simulation of AC models using larger time steps than the traditional time
formulation.

Use frequency-time equation forumulation to speed up your simulation when:

* Your simulation contains periodic AC signals with a common fundamental frequency

* You are interested in the slow-moving AC-related quantities, such as amplitude or
phase, and the DC output signals

Set up the model

To measure the time required to run a simulation, open the model pe sm_control and
create a model callback.

mdl = load system('pe sm control');
open_system(mdl) ;

set param(mdl, 'StartFcn', 'tic;");

set param(mdl, 'StopFcn', 'tsim=toc;"');
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This example shows how to contred and initialize a Synchronous Machine (SM). Initial Load Step off Step on

The te:

st circuit shows the SM operating as a generator. The terminal voltage is

confrolled using an AVR and the speed is controdled using a governor.

To view the SM machine base values and initial conditions, right-click the SM
block and select 'Power Systerns' and then 'Display Base Values',

‘Display Associated Base Values'. or 'Associated Initial Conditions'.

The overall model is initialized to start in pericdic steady state to supply a
load of 250 MWI15 Mvar.

Edit associated script.
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Run asscciated script to plot data.
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Run a time-based simulation

Double-click the Solver Configuration block and apply the following configuration:

* Enable the local solver by checking the Use local solver check box
* Set the Sample time parameterto le-3
* Set the Equation formulation parameter to Time

You can also run this code to configure the block.

blk = find system(mdl, 'MaskType', 'Solver Configuration');
set param(blk, 'UseLocalSolver','on');

set param(blk, 'LocalSolverSampleTime', '1le-3"');

set param(blk, 'EquationFormulation', 'NE TIME EF');

Simulate the model and save the run time and logging variable.

sim(get _param(mdl, 'Name'));
tsim_time = round(tsim,2);
pe sm control simlog time = pe sm control simlog;

Run a phasor-mode simulation
Double-click the Solver Configuration block and apply the following configuration:

» Enable the local solver by checking the Use local solver check box
* Set the Sample time parameter to le-2
* Setthe Equation formulation parameter to Frequency and time

You can also run this code to configure the block.

blk = find system(mdl, 'name', 'Solver Configuration');

set param(blk, 'UselLocalSolver','on');

set param(blk, 'LocalSolverSampleTime', 'le-2");

set param(blk, 'EquationFormulation', '"NE FREQUENCY TIME EF');

Simulate the model and save the run time and logging variable.

sim(get param(mdl, 'Name'));
tsim phasor = round(tsim,2);
pe sm_control simlog phasor = pe _sm control simlog;
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Compare DC results

Plot the field voltage and rotor speed for both the time and frequency-time simulations.
For each simulation mode, display markers at every 50 data points.

[hTime,hPhasor]=setup figure(pe sm control simlog time,pe sm control simlog phasor, 'dc
legend([hTime, hPhasor],{['Time (t=',num2str(tsim time),'s)'],['Phasor (t=',num2str(tsir

Terminal voltage (per-unit)
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The phasor simulation reproduces near-identical results as the time-based simulation,
despite using a time step that is 10 times larger. The measured simulation time is also
shown for each of the simulation modes in the plot legend. This performance indicator is
different on different machines, but the frequency-time simulation should be about two
times faster than the time simulation. Note that the actual time required per step is
higher in the frequency-time case, but the overal time is reduced.
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Compare AC results

Plot the a-phase voltage of the synchronous machine over the time period 1s to 1. 1s.
Because of the larger time steps in the frequency-time formulation, the resolution of the
AC quantity is too small to make out the sine wave. The points that are available are
undersampled, but still accurate.

[hTime,hPhasor]=setup figure(pe sm control simlog time,pe sm control simlog phasor, 'ac
legend([hTime, hPhasor],{['Time (t=',num2str(tsim time),'s)'],['Phasor (t=',num2str(tsir
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In general, use frequency-time formulation to speed up simulations where the outputs of
interest are DC or slow-moving AC quantities. You can use periodic sensors to measure
slow-moving properties of AC signals such as amplitude and phase in both time and
frequency time formulations. For more information, see the Harmonic Estimator block.
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See Also

Sometimes there are small phase offsets between time- and frequency-time-generated AC
signals. This difference is caused by the accumulated integration error of a slightly
different signal frequency over time.

See Also

Solver Configuration

More About

. “Frequency and Time Simulation Mode” (Simscape)
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